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Chapter 1
How to get help

This section explains how to get help for Nortel products and services.

Getting Help from the Nortel Web site
The best way to get technical support for Nortel products is from the Nortel
Technical Support Web site:

http://www.nortel.com/support

This site provides quick access to software, documentation, bulletins, and
tools to address issues with Nortel products. More specifically, the site
enables you to:

• download software, documentation, and product bulletins

• search the Technical Support Web site and the Nortel Knowledge Base
for answers to technical issues

• sign up for automatic notification of new software and documentation
for Nortel equipment

• open and manage technical support cases

Getting Help over the phone from a Nortel Solutions Center
If you don’t find the information you require on the Nortel Technical Support
Web site, and have a Nortel support contract, you can also get help over the
phone from a Nortel Solutions Center.

In North America, call 1-800-4NORTEL (1-800-466-7835).

Outside North America, go to the following Web site to obtain the phone
number for your region:

http://www.nortel.com/callus
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10 Chapter 1 How to get help

Getting Help from a specialist by using an Express Routing Code
To access some Nortel Technical Solutions Centers, you can use an Express
Routing Code (ERC) to quickly route your call to a specialist in your Nortel
product or service. To locate the ERC for your product or service, go to:

http://www.nortel.com/erc

Getting Help through a Nortel distributor or reseller
If you purchased a service contract for your Nortel product from a distributor
or authorized reseller, contact the technical support staff for that distributor
or reseller.
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Chapter 2
Overview

In this chapter
"General" (page 11)

"Reference documents" (page 12)

General
This troubleshooting reference guide describes symptoms that can appear
on all CallPilot server platforms, and provides step-by-step troubleshooting
procedures. The troubleshooting procedures can be slightly different for
different CallPilot releases.

Each troubleshooting area contains symptom tables outlining basic checks
that include diagnostics and resolutions for each check. This guide is
applicable to all CallPilot servers. The exceptions are noted for each server,
where necessary, in the heading for each symptom or check.

This document provides only basic troubleshooting procedures. You can
find additional troubleshooting information in the CallPilot documents that
are referenced throughout this document.

Note: To comply with the Restriction of Hazardous Substances (RoHS)
Directive 2002/95/EC, some of the part numbers now contain an E5 or
E6 suffix. For example, part number NTRH2014 is now NTRH2014E6.
The part numbers in this guide do not contain the suffix.
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Chapter 3
Hardware troubleshooting

In this chapter
"201i server" (page 13)

"703t server" (page 17)

"1002rp server" (page 28)

"1005r server" (page 41)

"600r" (page 50)

201i server
System troubleshooting

Trouble Action

The system emits beep
codes.

The state of the PC chip set is associated with beep codes. Some
codes indicate relatively harmless failure situations that allow you
to start up the CallPilot server, even though the system is not fully
functional unless you solve the trouble.

Some beep codes indicate catastrophic failures that cannot be
easily resolved at the customer site. For example, the series of
beep codes 1-3-3-1 indicates a defective or missing memory DIMM.
Declare the system an out-of-box failure (OBF) and return it to the
channel partner.

Note: The 201i server emits one pulse beep at startup. This is a
normal beep and does not indicate a system failure.
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14 Chapter 3 Hardware troubleshooting

Trouble Action

The HEX display is not on
at startup.

The system can be in a catastrophic failure state.

• The power supplies have malfunctioned.

• The 8051 system controller failed.

The 8051 system controller and the HEX display work together and
perform a quick system hardware test before the operating system
starts up.

Refer to the 201i Server Maintenance and Diagnostics document
(NN44200-705) for information on interpreting the HEX display.

The red light on the back of
the 201i board is on.

The onboard DSP field programmable gate array (FPGA) is not
loading properly. Sometimes the system boots to the operating
system, but CallPilot does not function. Declare the system an OBF
and return it to the channel partner.

The DSP card socket light
is on, but no DSP card is
plugged in.

The DSPs failed to load. Sometimes the system boots to the
operating system, but CallPilot does not function. Declare the
system an OBF and return it to the distributor.

The server does not fit or
seat properly into the shelf.

ATTENTION
Do not force the 201i server into the shelf.

Ensure that you set the proper physical spacing on the back of
the server. The Option 11 and Meridian 1* cabinets have two
different card-spacing options. Use a Phillips screwdriver to
adjust the bracket on the back of the 201i server (the backplane
card edge connector). Refer to the 201i Server Hardware
Installation guide (NN44200-301).

The green HEX display
indicates that the system
works properly and you
hear the hard drive spin,
but no information is
displayed on screen.

Verify that the monitor is properly connected to the power supply
and to the CallPilot server. Ensure that the monitor is not defective.

If the system still does not display information on screen, then
declare the system an OBF and return it to the distributor.
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201i server 15

SCSI peripheral troubleshooting

Trouble Action

The system does not start
from the CD-ROM.

Note: The 201i server does not support this feature at this time.

The system displays
error messages while
the operating system is
installed from the CD-ROM.

Ensure that the most recent version of the CD-ROM SCSI driver is
installed on your system.

Newer CD-ROM drives are very fast, and the cables that connect
them to the server can be too long. The faster the SCSI CD-ROM
runs, the shorter the cable must be. The newest CallPilot SCSI
drive driver is a de-stroked driver, which forces the SCSI drive to
run more slowly and reliably with longer SCSI cables supplied by
Nortel. If you get random installation errors during the loading of the
operating system, then the SCSI driver installed on your system is
not the most recent.

The CD-ROM drive is not
shown in the operating
system.Errors occur during
CD-ROM or tape operation.

Because the SCSI cable can be plugged and unplugged from the
faceplate of the 201i server, the cable connector pins can get bent
or pushed in.

Inspect the connector of the SCSI cable and ensure that all the
connector pins are straight and level. Ensure that the cable is
properly and fully plugged in and latched to the 201i server faceplate.

When installing a new CD-ROM or external tape drive, you need to
reboot the system before it recognizes the new hardware.

Ethernet cable troubleshooting

Trouble Action

The Ethernet link LEDs are
not on.

When an Ethernet cable is properly connected at both ends, the link
LED associated with the Ethernet connector must be on at both ends
of the Ethernet cable even when the operating system is not running.

The 201i faceplate has a row of four green LEDs labelled E, C, I,
and S.

• The leftmost LED (E) is associated with the ELAN link.

• The second LED (C) is associated with the CLAN link.

Nortel CallPilot
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16 Chapter 3 Hardware troubleshooting

Trouble Action

• The other two LEDs indicate the IDE (I) and SCSI (S) activity
of the following devices:

— IDE (I)

— SCSI (S)

If the Ethernet link LEDs are not on, check the Ethernet cabling.

Note: The link LEDs blink to indicate network activity.

The CallPilot Nortel server
subnet does not work when
the server is connected to
a large Meridian 1 system.

The 201i server uses two auto-negotiating Ethernet network interface
cards (NIC). When the NICs are connected to a 10/100Base-T port,
they try automatically to negotiate transfer rates at the higher speed.
The large Meridian 1 systems have filtered backplanes that generate
loss on all signals, except on the signals routed to the bottom four
pins (the ELAN subnet pins). As a result, the server can go into a
loop or appear unresponsive on the Nortel server subnet.

• Use an unfiltered Ring/Tip cable supplied by Nortel.

or

• Remove the filter block on the back of the Meridian 1 newer
systems and connect the switch directly to the 201i server I/O
cable.

CAUTION
Dangerous voltage levels can be present in the
back of the Meridian 1 switch. Use the proper
cable, as indicated in the 201i Server Hardware
Installation guide.
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703t server
Server LEDs

The LEDs indicate the state of your server and can help you troubleshoot
startup problems. The following tables provide useful information on the
external and internal LEDs.

External LEDs

Description Information

MPB96 DS30 link LEDs
(three green LEDs located
on the card bracket and
visible from the back of the
server)

When these LEDs are on, all three DS30 connections are working
properly and the cables are connected correctly. If one or more
LEDs is off, one of the following conditions is present:

• One or more connections to the switch is interrupted. Check
each of the three branches of the DS30 cable for faults, or
replace the cable.

• An MGate card in the switch is defective.

Blue LED at the back of the
server

This LED is currently not used. The blue LED comes on only for a
moment at server startup.

NIC LEDs Each network interface card (NIC) has two LEDs:

• The upper LED shows that the network cable is connected.

• The lower LED blinks to indicate data transfer.

Internal LEDs

Description Information

MPB96 board LEDs The three red LEDs at the top of the MPB96 board are visible
through the grill at the back of the server.

• The PCI FPGA Done LED (the closest to the card I/O bracket)
comes on at startup and turns off immediately. This indicates
that the board works properly and was detected correctly by
the system. If this LED stays on after the startup, the card is
defective and must be replaced.

• The DSP FPGA Done LED comes on at startup and stays on
until the CallPilot drivers are loaded and the diagnostic screen is
displayed. If the LED stays on after the operating system has

Nortel CallPilot
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18 Chapter 3 Hardware troubleshooting

Description Information

started and the CallPilot diagnostic screen has appeared, then
the MPB96 board is defective or the DSP and NTBus drivers
do not function properly.

• The CTbus FPGA Done LED (the farthest from the card I/O
bracket) works in tandem with the DSP FPGA Done LED and
turns on and off at the same time.

RAID controller LEDs The RAID controller has one red LED and eight small LEDs at the
back. When the card works properly, the red LED comes briefly on
at startup indicating that the card was accessed for detection. At the
same time, all eight LEDs at the back of the card come on, and then
half of them turn off and stay off. Four lit LEDs at the back of the
card indicate that the card works properly. If all eight LEDs stay on
after startup, the card was not detected or is defective.

BMC beep codes
The main board used in the 703t server includes a baseboard management
controller (BMC) that provides monitoring, alerting, and logging of critical
system information obtained from sensors embedded on the board.

The BMC generates beep codes when it detects failure conditions. Each
digit in the code represents a sequence of beeps.

Beep code Reason

1 Front panel CMOS clear initiated

1-5-1-1 Fault resilient booting failure (processor failure)

1-5-2-1 No processor installed or empty processor socket 1

1-5-2-3 Processor configuration error (for example, mismatched voltage identifications
and empty processor socket 1

1-5-2-4 Front-side bus select configuration error (for example, mismatched BSELs)

1-5-4-2 Power fault: dc power unexpectedly lost

1-5-4-3 Chipset control failure

1-5-4-4 Power control failure

Nortel CallPilot
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System troubleshooting

Trouble Action

The system does not boot
and appears dead. The
system does not emit any
beeps. The fans do not
turn.

Verify that the power cord is properly plugged in the power outlet.

Check if other equipment plugged in the same power outlet works.

Note: If the fans are turning, but the system emits no beeps, verify
that:

• The monitor is turned on.

• The power cord to the board (processor and main) is plugged
in correctly.

The system does not start,
but emits beeps.

Identify the type of beeps that your system emitted: system board
beeps or RAID beeps.

• The system board beeps are usually short; their pattern is
identified in the 703t Server Maintenance and Diagnostics
guide (NN44200-702). The system board beeps are usually
not associated with information displayed on the screen. If the
system does not display information on the screen but emits
board beeps, then a main board condition is present.

• The RAID beeps are high-pitched and long. The RAID beeps
emitted by the system during startup are associated with
messages indicating that a system is in a critical state.

Check the status LED at the front for a blinking or steady amber
light, which indicates that:

• A critical temperature or voltage fault has occurred.

• The CPU was not installed or is not functioning.

Check the beep codes provided in the 703t Server Maintenance
and Diagnostics guide to identify the failure, and then replace the
defective component or remedy the fault.

Nortel CallPilot
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20 Chapter 3 Hardware troubleshooting

Trouble Action

The system beeps and
displays information on the
screen, but the operating
system does not start up.

This is a typical RAID beep. One of the following condition is present:

• One cable or both cables from the hard drives is disconnected
or improperly connected.

• One or both drives is faulty.

In special situations, this symptom indicates that the NVRAM
contents and the drive configuration were lost. The data is still there,
but the system beeps and shows that both drives are faulty. Perform
a data recovery by configuring the drives as indicated in the 703t
Server Maintenance and Diagnostics guide, without initializing the
logical drives.

The system starts the
operating system, but still
beeps.

This symptom typically indicates a RAID trouble: one of the hard
drives is in critical condition. Rebuild the drive as soon as you get
to the operating system; refer to the 703t Server Maintenance and
Diagnostics guide. If the drive rebuilding does not work, then the
drive is defective and must be replaced.

The system does not boot
to CallPilot.

This symptom can indicate a multimedia card failure or a software
failure.

Check for multimedia card errors on the diagnostic screen that
appears immediately after the system boots. If the multimedia card
functions properly, then investigate the software area; check the
Event Viewer for information on software failures.

The system starts, but
displays the following
error message: PXE-E61
Media failure;
please check cable

This is a critical message that appears when the ELAN or CLAN
cable is not plugged in.

Ensure that the ELAN and CLAN cables are properly plugged in.

Nortel CallPilot
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Trouble Action

The system starts up and,
immediately after the video
information string displays
an error message such
as the following: PCI
vendor ID does not
match the Device ID.

This is not a critical error message.

In CallPilot 3.0, this trouble has been fixed by upgrading the BIOS.

For previous CallPilot releases, ensure that the Ethernet controllers
are enabled in the BIOS. The error message can appear, for
example, when one of the Ethernet controllers is disabled in the
BIOS.

The system board displays
an error message in red
and does not start up.

This is a Management Controller failure. This failure is serious and
occurs because a board in the system was replaced, but the server
was not shut down and unplugged.

You must unplug the power cord when swapping boards to avoid
causing server damage. When the error message appears, shut
down the server, unplug the power cord, wait for a minute, and then
plug the cord back in. If this action does not remedy the trouble,
call Nortel support.

SCSI troubleshooting

Trouble Action

The system does not
scan the Adaptec SCSI
controller BIOS startup. No
information on the SCSI
controller is displayed
during startup.

The SCSI controller is disabled in the BIOS.

Open the BIOS and enable the Adaptec SCSI controller.

The tape drive is detected
during startup, but not in
the operating system. As
a result, no backup can be
performed.

The SCSI controller is configured as a RAID system.

Press Ctrl+A at startup to open the SCSI main menu and proceed
as follows, depending on your CallPilot release:

• CallPilot 3.0 and up (new systems): ensure that the HostRAID
option is set to Disabled in the SCSI settings.

• CallPilot 2.x: ensure that the HostRAID setting is set to Enable
HostRAID.

Nortel CallPilot
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22 Chapter 3 Hardware troubleshooting

RAID troubleshooting

Trouble Action

The system boots and
generates beeps.

One or more logical drives is in critical mode (one of the drives is
in FAIL condition).

Rebuild the drives. If the drive rebuilding is unsuccessful, replace
the drives.

The system does not detect
the RAID card.

The RAID card can be defective. Check the LEDs on the back of
the card. If more than four LEDs are on, the RAID card is defective
or the incorrect RAID firmware is used. Refer to either the 703t,
1002rp, 1005r or 600r Server Maintenance and Diagnostics guide
for valid RAID firmware.

• Ensure the RAID card is seated in the slot and the cables are
connected to the disk drives.

• Replace the RAID card.

The system detects the
RAID card, does not boot,
and attempts to boot from
the network.

The logical hard drive that has the booting partition is offline or both
physical drives on the booting logical drive are faulty.

• Press Ctrl+M at startup to open the MegaRAID BIOS
Configuration utility.

• Recreate the RAID pack without initialization.

• Restart the server.

If the drives were offline, this action restores their functionality. If this
solution does not remedy the trouble, replace the defective drives.

Note: If you brought the hard drives offline deliberately or performed
a RAID splitting operation, then you must not recreate the RAID pack
without initialization.
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MPB96 board troubleshooting 23

Trouble Action

The system does not
rebuild a new drive installed
to replace a faulty drive.

When you replace a defective drive, the new drive must be larger
than the original drive. In this case, the system rebuilds the new
drive.

However, if the new drive is smaller than the original drive, it must
not be smaller by more than 1 GB. If the new drive is smaller than the
original drive by less than 1 Gbyte, the GBWay setting in the Adapter
properties is disabled. Enable the GBWay setting and start a new
RAID configuration. Because starting a new RAID configuration
erases the existing data, back up the system before proceeding.

The system does not rebuild a drive if an incorrect combination of
operating system utility and RAID firmware is used on your system.
Refer to either the 703t, 1002rp, 1005r or 600r Server Maintenance
and Diagnostics guide for valid RAID firmware.

Note: Non-supported combinations of operating system utility and
RAID firmware can corrupt your system and prevent drives from
rebuilding.

The system does
not rebuild the drive
automatically after you
replaced a faulty drive.

The Automatic rebuild feature is disabled in the BIOS on the 703t
platform. Initiate the rebuilding process manually in the Windows
MegaRAID utility.

MPB96 board troubleshooting
The following section describes the tools that you can use to troubleshoot
the MPB96 board.

FWChecker.bat

ATTENTION
Risk of data loss
The FWChecker.bat tool is packaged with the dbg128.exe utility. Do not use the
dbg128.exe outside the FWChecker.bat tool. You can destabilize or crash your
system, and lose data.

The FWChecker.bat tool checks the FPGA firmware on the MPB96 board.
The dbg128.exe file must be present in the same directory so that you can
run the to be able to run the FWChecker.bat tool. Two versions of the
FWChecker.bat tool are available:

• CallPilot 3.0: version 2.0, September 2004
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• CallPilot 2.0x: version 1.0, May 2003

The CallPilot system contains two types of FPGA firmware.

FPGA firmware Description

PCI FPGA The version format of the PCI FPGA firmware follows an internal
naming convention established to facilitate the tracking of the card
release. The tool displays the version in hexadecimal format as
follows: xPxx yyaNN, where

• x must be 0

• P represents the PCI slot: 8 for 3.3V PCI slot and 0 for 5V PCI
slot

• yy designates the board release: 07

• NN is the firmware release; as NN is currently 17, the release
number for the GA is a17

If the release number is 080007a17, then the board operates
correctly. If the release is shown as a17 only, then the board is
plugged into the incorrect slot (5V PCI slot). If the PCI FPGA
firmware releases do not match, you must return the board to the
factory for update.

DSP FPGA The version of the DSP FPGA firmware is displayed in hexadecimal
format and must match the current release as displayed by the
FWChecker.bat tool. You can upgrade the DSP FPGA firmware
using the supplied software tools, such as the hardware abstraction
layer (HAL) tool.

XRay Monitor
This tool opens all the MPB96 board registers. In certain cases, you can
reset the registers to the startup state.

You need two utilities to run the XRay Monitor tool: Nbhaltswcmd.exe and
nbhaltswmon.exe.

Use the XRay Monitor tool as follows:

Step Action

1 Launch Nbhaltswcmd.exe.

2 Select option c (MPB96).

3 Select option m (XRay Monitor)
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4 Select the board number; that is, the slot in which the board is
installed (for example, 4 for a 703t system connected to a Meridian 1
switch).

5 Select option 5 (500 ms polling time)

Result: The system launches the nbhaltswmon.exe utility and
displays a screen containing all the MPB96 registers. The status of
the registers indicates the status of the card. You can interpret the
card status by reading the bit significance in the MPB96 Unified
document.

The following examples illustrate the interpretation of register status:

—End—

Register Remarks

Link in/Link out If all the parameters are set to 0, then no connection is made in
the time switch memory.

PLL control If the value displayed ends with 311 or 226, the board is configured
as slave; that is, it takes Voice bus clocking from a card configured
as master. If any other value is displayed, then the board is
configured incorrectly.

PLL status The typical value for a working system is 0x40077003. For example,
if the value starts with 0x402xxxxx, then a target abort operation
occurred on the PCI bus. The card does not work properly. If the
values of the last four digits change, check the green LEDs on
the back of the card. The changing values indicate that the DS30
connection is not stable or was lost

PCI firmware This register indicates the version of the board and the type of slot
in which the board is plugged (5V or 3.3V). For example, a typical
value is 0x80000a16, which indicates that the board is plugged into
a 3.3V slot (slot 8). For the 5V slot type, the value is 0; this indicates
that the card is plugged into the wrong slot. The firmware version
is a16, which indicates a release 1 board.

DSP TA These registers have values when a target abort operation occurred
on a particular DSP. The DSP TA registers contain only zeroes
when the card operates normally.

Dbg128.exe

ATTENTION
Risk of data loss
If you use the dbg128.exe utility without fully understanding its functions, you can
destabilize your system and cause a system crash or data corruption. Use this
tool only under the supervision of the Design team.
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The dbg128.exe is an extremely powerful tool designed for debugging the
MPB96 board. It can replace all the preceding tools and provide full control
over all the MPB96 registers and memory.

Windows and CallPilot hardware troubleshooting

Trouble symptom Action

The system beeps, but
seems to be running
properly and taking calls.

This is a RAID card beep indicating that one of the drives does not
function properly. Do not shut down the system.

• Open the MegaRAID Client (CallPilot 2.x) or Power Console
Plus (CallPilot 3.x) utility, and check which drive is marked as
Dead.

• Rebuild the drive marked as Dead.

If the rebuild is unsuccessful, ensure that the other drive is working,
then shut down the system and replace the drive marked as Dead.

The system displays a blue
screen with the following
message: Hardware
Malfunction, please
contact your H/W
vendor.

The system does not take
calls.

Check the release of the MPB96 board. The blue screen appears
if the MPB96 board release is 5 or earlier, and the version of the
system BIOS is other that P07, build 64.

If the MPB96 board release is 6 or later, the system BIOS release is
irrelevant.

Update the MPB96 board to release 6 or later to solve this trouble.

All DSP diagnostics fail at
system startup.

Shut down the server and open the lid. Turn on the server and
check if the PCI LED on the MPB96 board is still on after startup.
If the LED is still on, then shut down the server, reseat the board,
and then turn on the server again.

• If the LED is still on, the board is defective and must be replaced.

• If the LED goes on and then off, but the DSP and CTbus
FPGA LEDs are still on after the system booted completely to
the operating system, then check the HAL and ensure that all
its components are working properly. If the HAL components
function properly, then at least one of the ctbus.mcs or dsp.mcs
files is corrupted. Replace these files and reboot the system. If
the PCI LED still stays on, then the MPB96 board is defective
and must be replaced.
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Trouble symptom Action

The system starts up, but
attempts to boot to the
operating system from the
network.

Shut down the server and open the lid. Turn on the server and
check the RAID controller LEDs. If more than four LEDs stay on
after the startup, then the problem is related to the RAID controller.

• Shut down the system.

• Reseat the RAID controller.

• Reboot the system.

If these actions do not resolve the trouble, then the RAID card is
defective and must be replaced.

The system ELAN or
CLAN are not working,
even though they are
detected and displayed
in the operating system
control panel.

Enable the NIC controllers in the BIOS.

The system displays
an error message after
CallPilot languages have
been installed.

There is an older version of the RAID controller firmware. Upgrade
the RAID firmware to a currently support version. Refer to either the
703t, 1002rp, 1005r or 600r Server Maintenance and Diagnostics
guide for valid RAID firmware.

The HAL does not detect
the MPB96 board. All the
DSPs report failures in the
diagnostic window.

The MPB96 board is not installed in the correct slot.

• Refer to the 703t Server Hardware Installation guide for the
correct number of the slot in which the MPB96 board must be
installed.

• Shut down the system.

• Install the MPB96 board in the proper slot.

The system does not
detect the MPB96 board
after CallPilot has been
migrated from an earlier
platform.

• Check if the system is detected correctly in the HAL; that is, if
the platform information file matches your system information.

• If the platform information and the system information do not
match, then load the correct platform information file into the
registry.
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Trouble symptom Action

The system detects the
MPB96 board only partially,
and Configuration Wizard
does not run.

The MPB96 board is configured incorrectly from the clocking point
of view.

Contact your Nortel support representative for assistance.

The system detects the
MPB96 board, but does
not load correctly the DSP
information at startup.

The cache.bin file in the D:\nortel\hardware\dsp\c52\ folder is
corrupted.

Rerun the Configuration Wizard to reflash the DSPs.

1002rp server
The LEDs indicate the state of your server and can help you troubleshoot
startup problems. The following tables provide useful information on the
external and internal LEDs.

External LEDs

Description Information

Fan fault Two LEDs at the front of the server indicating the status of the fans

Disk activity Six LEDs at the front of the server indicating the status of the disk
drives

Pwr spply Indicates the status of the power supply

Fan Indicates that the fan functions normally

Power on Indicates that the server is on

Over temp The temperature inside the server is above the safety threshold.
This LED indicates that both fans are faulty.

Fault Comes on when the Pwr spply, Over temp or Fan fault LED come on.

MPB96 DS30 link LEDs
(three green LEDs located
on the card bracket and
visible from the back of the
server)

When these LEDs are on, all three DS30 connections are working
properly and the cables are connected correctly. If one or more
LEDs is off, one of the following conditions is present:

• One or more connections to the switch is interrupted. Check
each of the three branches of the DS30 cable for faults, or
replace the cable.

• An MGate card in the switch is defective.
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Description Information

Network interface card
(NIC) LEDs

Each NIC has two LEDs:

• The upper LED shows that the network cable is connected.

• The lower LED blinks to indicate data transfer.

Internal LEDs

Description Information

MPB16-4 board LED The five LEDs at the top of the MPB16-4 board are visible through
the grill at the back of the server.

• The four DSP Power On LEDs come on when the CallPilot
drivers are loaded, right before the diagnostic screen starts.
If these LEDs are not on after the system has booted to the
operating system and the diagnostic screen has started, then
one of the following conditions can be present:

— The board is faulty and must be replaced.

— The CallPilot DSP and the NTBus drivers do not function
properly.

— The DSP card to which the LED belongs is faulty.

• The PCI FPGA Done LED (the farthest from the card bracket)
comes on briefly at startup. If this LED stays on after system
startup, then the MPB16-4 card is faulty and must be replaced.

MPB96 board LEDs The three red LEDs at the top of the MPB96 board are visible
through the grill at the back of the server.

• The PCI FPGA Done LED (the closest to the card I/O bracket)
comes on at startup and turns off immediately. This indicates
that the board works properly and was detected correctly by
the system. If this LED stays on after the startup, the card is
defective and must be replaced.

• The DSP FPGA Done LED comes on at startup and stays on
until the CallPilot drivers are loaded and the diagnostic screen is
displayed. If the LED stays on after the operating system has
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Description Information

started and the CallPilot diagnostic screen has appeared, then
the MPB96 board is defective or the DSP and NTBus drivers
do not function properly.

• The CTbus FPGA Done LED (the farthest from the card I/O
bracket) works in tandem with the DSP FPGA Done LED and
turns on and off at the same time.

RAID controller LEDs The RAID card has one red LED and eight small LEDs on the back.
When the card works properly, the red LED comes briefly on at
startup; this indicates that the card was accessed for detection. At
the same time, all eight LEDs at the back come on, and then half
of them turn off and stay off. Four LEDs lit at the back of the card
indicate that the card works properly. If all eight LEDs stay on after
startup and boot, the card was not detected or is defective.

BIOS beep codes
During the power-on self test (POST) routines performed each time that the
system is powered on, various errors can occur.

Error type Description

Non-fatal error In most cases, these error allow the system to continue the bootup
process. Error messages normally appear on the screen.

Fatal error These errors do not allow the system to continue the bootup process.

The following table describes the errors communicated by beeps.

Beep
count

Message Description

1 Refresh Failure The memory refresh circuitry of the processor board is
faulty.

2 Parity error A parity error was detected in the base memory (the first
block of 64 kbytes of the system).

3 Base 64KB Memory Failure A memory failure occurred in the first 64 KB of memory.

4 Timer Not Operational A memory failure occurred in the first 64 KB of memory, or
Timer #1 on the processor board failed to function properly

5 Processor Error The CPU on the processor board generated an error.

6 8042 - Gate A20 Failure The keyboard controller (8042) contains the Gate A20
switch, which allows the CPU to operate in protected
mode. This error message means that the BIOS is not
able to switch the CPU in the protected mode.
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Beep
count

Message Description

7 Processor Exception
Interrupt Error

The CPU on the processor board generated an exception
interrupt.

8 Display Memory
Read/Write Error

The system video adapter is missing, or its memory is
faulty.

Note: This error is not fatal.

9 ROM Checksum Error The ROM checksum value does not match the value
encoded in the BIOS.

System troubleshooting

Trouble symptom Action

The system appears dead.

• The server does not
boot.

• The server emits no
beeps.

• The fans do not turn.

• Check if the power cord is properly plugged in the power outlet.
If the system is a direct current (dc) version, the power cables
can be reversed; ensure that the polarity of the cables is correct.

• Ensure that the breaker corresponding to the cable is in the ON
position.

• Ensure that the correct type of cable is used, depending on the
type of power supply (ac or dc).

• Check if other equipment plugged in the same power outlet
works.

Note: If the fans are turning, but the system emits no beeps, check if
the monitor is turned on.

Check if the two LEDs on the power supplies (at the back of the
server) are on or red.

• If the LEDs are not on, check the power supply fuse.

• If the LEDs are on and red, one or both power supplies is not
plugged in or plugged in incorrectly, or the connection pins on
the power supplies are bent or missing.
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Trouble symptom Action

The system does not
start, but emits beeps. No
information is displayed on
screen.

Identify the type of beeps that your system emitted.

• The system board beeps are usually short; their pattern is
identified in the 1002rp Server Maintenance and Diagnostics
guide (NN44200-300). The system board beeps are usually not
associated with information displayed on screen.

• The RAID beeps emitted by the system at startup are associated
with messages indicating that the system is in a critical state.
The RAID beeps are high-pitched and long. Press Ctrl+M at
startup to open the MegaRAID BIOS Configuration utility and
check for a faulty or disconnected drive.
The system also emits RAID beeps when a RAID splitting
procedure is performed. However, these beeps do not indicate
a fault condition.

• A continuous high-pitched beep indicates a chassis condition
and is usually associated with a LED lit on the front of the
chassis (power supply, fan, or over temperature).

If the power supply is the cause of the beep, look at the back
of the server and identify the defective power supply (the LED
is red or off). The power supply can be plugged in incorrectly.
Unplug the power cord, check the pins, and plug the cord back
in. If the condition persists, replace the power supply.

If a fan is defective, replace it. You can hot-swap the fans.

The over temperature condition appears when both fans are
faulty.

• Sets of 1 through 11 intermittent beeps indicate faults associated
with the following hardware.

The system displays
information on screen,
emits long beeps separated
by pauses, but does not
boot to the operating
system.

These are typical RAID beeps. If the system does not boot, one of
the following conditions can be present:

• One cable or both cables from the hard drives are disconnected
or improperly connected.

• One or both drives are faulty.

In special situations, the NVRAM contents and drive configuration
were lost. The data is still there, but the system beeps and shows
that both drives are faulty. Perform a data recovery by configuring
the drives as indicated in the 1002rp Server Maintenance and
Diagnostics guide, without initializing the logical drives. Open the

Nortel CallPilot
Troubleshooting Reference Guide
NN44200-700 01.05 Standard

5.0 26 June 2007
Copyright © 2007, Nortel Networks

.

Download from Www.Somanuals.com. All Manuals Search And Download.



1002rp server 33

Trouble symptom Action

Ctrl+M utility at startup, and ensure that the RAID setup matches
the settings indicated in the 1002rp Server Maintenance and
Diagnostics guide.

The system boots to the
operating system and
beeps intermittently.

ATTENTION
Do not reboot your system!
This symptom typically indicates a RAID problem: one of the
hard drives is in critical condition. Rebuild the drives as soon
as your system boots to the operating system. If the drive
rebuilding does not work, then the drive is defective and must
be replaced.

Use the Ctrl+M or MegaRAID utility to remedy the trouble as
indicated in the 1002rp Server Maintenance and Diagnostics
guide. Do not disable the alarm. You can silence the alarm in
the utility instead.

The system display
information on the screen,
but does not boot to the
operating system. The
startup routine stops
after the RAID status is
displayed; the cursor blinks
on the screen.

The system BIOS is configured incorrectly. The setting
"Chipset\Allow card to trap INT19" is set to Yes. Reboot, open the
BIOS and set the setting "Chipset\Allow card to trap INT19" to No.
Ensure that all the BIOS settings are as indicated in the 1002rp
Server Maintenance and Diagnostics guide.

The system displays
information on screen,
but does not boot to the
operating system and
does not detect the RAID
controller card.

One of the following conditions affects the system:

• The RAID controller is defective—more than four LEDs at the
back of the card are on.

• The PCI bridge that drives the first four PCI slots on which
the RAID card resides is defective, or the bridge pins are
disconnected or short-circuited.

Replace the RAID card. Refer to either the 703t or 1002rp Server
Maintenance and Diagnostics guide for valid RAID configurations.

If this action does not remedy the trouble, move the RAID card into
the next set of four PCI slots and reboot the system.
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Trouble symptom Action

• If the system boots correctly, consider replacing the PCI
backplane because it is only partially functional.

• If the system does not boot correctly, replace the PCI backplane.

Note: Each set of four slots is controlled by a different PCI bridge.
When you move the RAID card to the next set of four PCI slots, you
try to determine if the PCI bridge that controls the set of four PCI slots
in which the card was initially installed is defective.

The system boots, but the
keyboard or the mouse or
both are not functional.

The Y cable is connected incorrectly or is not the cable that Nortel
shipped with the system. The Y cable can also be plugged in
improperly.

The system does not boot
to CallPilot.

This symptom can indicate a multimedia card failure or a software
failure.

Check for multimedia card errors on the diagnostic screen that
appears immediately after the system is rebooted. If the multimedia
card functions properly, then investigate the software area; check
the Event Viewer for information on software failures.

The RAID controller
card displays SCSI IDs
from 0 to 6 for the hard
drives, although they are
configured on different
channels.

The jumpers of the SCSI drive backplane are installed. Remove
the jumpers. The displayed SCSI IDs must be from 0 to 2 on both
channels.

The RAID controller
displays the drives on the
second section as being on
channel 1 (the established
channels are 1 and 2).

The SCSI cables that connect the RAID controller card and the
SCSI drive backplane are inverted. Power down the system and
reconnect the cables so that they match the channels as indicated in
the 1002rp Server Maintenance and Diagnostics guide. The RAID
controller performs channel roaming without losing data.
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Trouble symptom Action

The Ethernet controllers
are enabled and detected,
but the ping command
fails when used to check
network resources.

• Open a DOS command prompt window.

• Type ipconfig /all.

The ipconfig command displays the MAC addresses. If the MAC
addresses are missing or have the same value, then they are not
programmed. Return the SBC card to the factory.

The software feature
key adapter (dongle) is
installed properly, but
CallPilot cannot detect it.

• Ensure that the software feature key adapter is plugged into the
parallel port. The DS30 connector on the adjacent MPB16-4
board is similar to the parallel port and can be confused with it.

• Ensure that all the flat cables inside the server have the red
stripe towards the end of the chassis. Reinstall any cable whose
red stripe is not in this position.

• Check the parallel port settings in the BIOS. No IRQ must be
assigned to the parallel port.

If you performed all the preceding tasks and CallPilot still does not
detect your software feature key adapter, return the board to the
factory.

SCSI troubleshooting

Trouble Action

The system BIOS does
not scan the Adaptec
SCSI controller at startup
(no SCSI controller is
referenced).

The SCSI controller is disabled in the system BIOS.

Open the system BIOS at startup and enable the SCSI controller.

The tape drive driver is
loaded but is not detected
and does not work.

The cause of this trouble can be one of the following:

• The tape drive is disconnected.

• The SCSI controller is disabled in the BIOS.

• The tape drive SCSI ID is set to 7
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Trouble Action

RAID troubleshooting

Trouble Action

The system boots but emits
beeps.

One or more logical drives are in critical mode (one of the drives
is in FAIL condition). Rebuild the drives. If the drive rebuilding is
unsuccessful, replace the drive.

The system does not detect
the RAID card.

The RAID card can be defective. Check the LEDs on the back of
the card. If more than four LEDs are lit, the RAID card or the PCI
backplane is faulty.

The system detects the
RAID card but does not
boot and attempts to boot
from the network.

The logical hard drive that has the booting partition is offline or both
physical drives on the booting logical drive are faulty.

• Press Ctrl+M at startup to open the configuration utility.

• Recreate the RAID pack without initialization.

• Restart the server.

If the drives were just offline, this action restores their functionality.
If this solution does not remedy the trouble, replace the defective
drives.

Note 1: If a drive is defective, the RAID utility determines the drive condition and marks the drive as
FAIL. Hot-swap the drive with a good one and then rebuild the drive. If you suspect that a drive is
faulty, simply remove it and replace it with a good drive.

Note 2: New 1002rp systems do not automatically rebuild a drive that replaced a faulty drive marked
as FAIL. You must rebuild the drive manually.

Note 3: On older 1002rp systems, the Autorebuild option is enabled by default in the RAID firmware.
Check this option and disable it before proceeding with RAID operations.
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Trouble Action

The system does not
rebuild a new drive installed
to replace a faulty drive.

When you replace a defective drive, the new drive must be larger
than the original drive. In this case, the system rebuilds the new
drive.

However, if the new drive is smaller than the original drive, it must
not be smaller by more than 1 Gbyte. If the new drive is smaller than
the original drive by less than 1 Gbyte, the GBWay setting in the
Adapter properties is disabled. Enable the GBWay setting and start
a new RAID configuration. Since starting a new RAID configuration
erases the existing data, back up the system before proceeding.

The system does not rebuild a drive if an incorrect combination
of operating system utility and RAID firmware is used on your
system. Refer to either the 703t or 1002rp Server Maintenance and
Diagnostics guide for valid RAID configurations.

Note: Non-supported combinations of operating system utility and
RAID firmware can corrupt your system and prevent drives from
rebuilding.

The system does not
rebuild a new drive (a little
smaller than the original
drive) installed to replace a
faulty drive.

The 1 Gbyte setting in the RAID Adapter properties is disabled.
Enable the 1 Gbyte setting and start a new RAID configuration.
Because starting a new RAID configuration erases the existing data,
back up the system before proceeding.

The system does
not rebuild the drive
automatically after you
replaced a faulty drive.

The system rebuilds a drive only if a change in the drive status is
made (after a SCSI scan). You must access the drive to initiate a
SCSI scan. The system does not start rebuilding the drive unless
you access the drive. Initiate a drive rebuild manually using the
MegaRAID utility.

Note 1: If a drive is defective, the RAID utility determines the drive condition and marks the drive as
FAIL. Hot-swap the drive with a good one and then rebuild the drive. If you suspect that a drive is
faulty, simply remove it and replace it with a good drive.

Note 2: New 1002rp systems do not automatically rebuild a drive that replaced a faulty drive marked
as FAIL. You must rebuild the drive manually.

Note 3: On older 1002rp systems, the Autorebuild option is enabled by default in the RAID firmware.
Check this option and disable it before proceeding with RAID operations.
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MPB16-4 board troubleshooting

Trouble Action

The CallPilot Diagnostics
tool reports that all or some
of the DSPs have failed.

Ensure that the release of your board is 05 or later.

If you have more than one MPB16-4 board in the server, ensure that
the SCBus cable is present and properly connected.

CallPilot starts up, but voice
services are not available.

You have more than one MPB16-4 board on your system. Ensure
that the DS30X cable is connected to the correct MPB16-4 board.

CallPilot works, but
the voice quality
is low—T1/SMDI
configurations only.

• Ensure that the release of the MPB16-4 board(s) is 05 or later.

• Ensure that the SCBus cable is not defective.

CallPilot works, but
no voice services are
available—T1/SMDI
configurations only.

Ensure that the PEC of your MPB16-4 board(s) is NTRH20BA.

Note: The T1/SMDI systems do not work with CallPilot systems
equipped with NTRH20AB MPB16-4 boards.

The Configuration Wizard
fails programming the
DSPs.

• Ensure that the latest CallPilot PEPs are installed on your
system.

• Ensure that no utility (such as Dspmon) that can access the
DSPs is running. The Nbhalnda utility (in the CallPilot tools)
cannot program DSPs accessed by more than one application.

The system does not
read some MPC8 cards,
displays DSP errors or
hangs at login.

• Check the MPC8 cards and replace the defective ones.

• Check the MPC8 socket pins on the carrier board and ensure
that they are not bent.

• Ensure that the MPC8 cards are plugged in properly. Do not
force the MPC8 cards backwards in the slots.
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Windows and CallPilot hardware troubleshooting

Trouble Action

The system beeps but
otherwise seems to be
running properly and taking
calls.

This is a RAID card beep indicating that one of the drives does not
function properly. Do not shut down the system.

• Open the MegaRAID utility and check which drive is marked as
Dead.

• Rebuild the drive marked as Dead.

• If the drive rebuild is not successful, ensure that the other drive
is functioning correctly.

• Power down the system and replace the drive marked as Dead.

Voice services from the
Meridian 1 switch are not
available after an upgrade.

• Ensure that the MGate card PEC is NTRB18CA or later.

• Ensure that the version of the MPB16-4 board is 05 or later.

The system stops taking
calls after a powerful
lightning storm.

The DS30 part of the system is affected. Replace the MGate card
to which the MPB16-4 board is connected.

The system plays voice
prompts but does not
record messages(T1/SMDI
configurations only).

Ensure that your system has the latest version of the Ctbus.mcs file.
This file is located in the D:\nortel\hardware\board\m96\ folder.

The system is affected by
the following symptoms:
frame slips, crackling
voice, fax dots, and alarms
(T1/SMDI configurations
only).

Ensure that the MPB16-4 board is release 5 or later.

Ensure that the cable used for the T1 connection is supplied by
Nortel and is not a category 4 or 5 cable.

Ensure that the SCBus or CTBus cable is not defective.
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Trouble Action

All DSP diagnostics fail at
system startup.

Ensure that the MPB16-4 boards are release 5 or later.

Ensure that the PCI backplane does not have Intel PCI bridge chips.

Shut down the server and open the lid. Power up the server and
check if the PCI LED on the MPB16-4 board is still on after startup.
If the LED still stays on, shut down the server and replace the board.

If the PCI LED comes on at system startup and then turns off, but
the other four green LEDs are still off after the system booted to the
operating system, check the HAL and ensure that all its components
are working properly. If the HAL components are working properly,
one or more MPC8 cards can be defective. Replace the defective
MPC8 cards.

If your system has two MPB16-4 boards and both have the same
symptoms, ensure that the correct driver is installed.

If only one MPB16-4 board seems to be defective, swap the boards.
If the presumed defective board works after the swapping, then the
PCI backplane is defective and you must replace it. If the presumed
defective board does not work, then you must replace it.

All the DSPs and DS30
links are reported as "All
busy", but the monitor
shows that the resources
are only partially busy
(Option 11 Meridian 1
configurations only).

The switch and the CallPilot system do not have the same ground
connection. Ensure that both systems are plugged into the same
power outlet and connected to a single-point ground reference.

The system starts up but
attempts to boot to the
operating system from the
network.

The RAID packs are either not configured or degraded. The RAID
system is not operational. Proceed as follows:

• Power down the system, plug the RAID card into the next set of
four PCI slots and then turn on the system. If the system boots
correctly to the operating system, then the PCI backplane is
defective and you must replace it.

• Power down the system, open the server lid and turn on the
system. If more than four lights remain on, the RAID controller is
faulty. Power down the system, reseat the controller card, and
turn on the system. If this action does not remedy the trouble,
then the RAID controller card is defective and you must replace
it.
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Trouble Action

The system ELAN or
CLAN are not working,
even though they are
detected and displayed
in the operating system
control panel.

Enable the NIC controllers in the BIOS, and ensure that the BIOS
settings are correct.

Open a DOS command prompt window and type ipconfig /all.
The ipconfig command displays the MAC addresses. If the MAC
addresses are missing or are the same, the MAC addresses are not
programmed. Return the SBC card to the factory.

The hard drives have
intermittent problems and
media errors.

Provide the serial number to Nortel support to check if your drive is
still covered by the warranty. The serial number provides the history
of the hard drive.

Open the RAID utility and check the status of each drive by looking
at the logical level and physical level. Ensure that no media or
surface errors are present.

Open the Checkdisk utility in the operating system and run it to
detect other type of hard drive errors.

Ensure that the firmware version of the RAID controller is valid.
Refer to either the 703t or 1002rp Server Maintenance and
Diagnostics guide for valid RAID configurations.

1005r server
The 1005r server is based on an Intel Langley Irwindale server platform with
advanced self-troubleshooting mechanisms. You can troubleshoot errors
by observing multiple areas:

• Visual – front or rear panel LEDs

• Audio or Sound – beeps or increased fan noise pitch

• Software – remotely using network intelligent modules (SNMP and/or
event logs).

If the system is powered on, you can access error reporting using the
CallPilot image CD/DVD SEL viewer tool (if the system does not boot into
Windows). This tool reports all hardware events and saves them as a text
file on a USB media.
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Server LEDs
The LEDs indicate the state of your server and can help you troubleshoot
startup problems. The following tables provide useful information about the
external and internal LEDs.

Front panel LEDs

LED Functional Description

CRT A critical system fault is an error or event that has a fatal system impact. The
system cannot continue to operate.

MJR A major system fault is an error or event that has a discernible impact on
system operation. The system can continue to operate but with reduced
performance or features.

MNR A minor system fault is an error or event that has little impact on system
operation. The system continues to operate.

PWR A power supply fault indicates that one of the power supplies is not providing
power. The MJR LED is also lit.

External LEDs

Description Information

MPB96 DS30 link LEDs
(three green LEDs
located on the card
bracket and visible from
the back of the server)

When these LEDs are on, all three DS30 connections are working
properly and the cables are connected correctly. If one or more LEDs
are off, one of the following conditions is present:

• One or more connections to the switch are interrupted. Check
each of the three branches of the DS30 cable for faults, or replace
the cable.

• An MGate card in the switch is defective.

NIC LEDs Each network interface card (NIC) has two LEDs:

• The upper LED shows that the network cable is connected.

• The lower LED blinks to indicate data transfer.

Power supply LEDs Each power supply has its own LED:

• OFF = system or power supply is off or faulty

• Red/Amber = power supply is faulty or cable is disconnected

• Green = power supply is working correctly and powered on
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Internal LEDs

Description Information

MPB96 board LEDs The three red LEDs at the top of the MPB96 board are visible through
the grill at the back of the server.

• The PCI FPGA Done LED (the closest to the card I/O bracket)
comes on at startup and turns off immediately. This indicates
that the board works properly and was detected correctly by the
system. If this LED stays on after the startup, the card is defective
and must be replaced.

• The DSP FPGA Done LED comes on at startup and stays on
until the CallPilot drivers are loaded and the diagnostic screen
appears. If the LED stays on after the operating system starts and
the CallPilot diagnostic screen appears, then the MPB96 board is
defective or the DSP and NTBus drivers do not function properly.

• The CTbus FPGA Done LED (the farthest from the card I/O
bracket) works in tandem with the DSP FPGA Done LED and
turns on and off at the same time.

POST beep codes
If an error occurs before video initialization, the POST emits beep codes
that indicate errors in hardware, software, or firmware.

A beep code is a series of separate tones, each equal in length. Record the
beep code sequence before calling Nortel technical support.

Beep count Description

1, 2, or 3 A Memory error occurred. Reseat the memory or replace the DIMMs with
known good modules.

4 – 7 or 9 – 11 A fatal error occurred and indicates a possible serious system problem.
Remove all the add-in cards and restart the system. If the error still
occurs, contact Nortel support. If the beep codes are not generated after
you remove the add-in cards, insert the cards one at a time, booting the
system between each card addition, until the beeps again occur to reveal
the malfunctioning card.

8 A problem with the onboard video card occurred indicating a fault on the
server board.

BIOS error messages
When a recoverable error occurs during the POST, the BIOS displays an
error message describing the problem.
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BIOS error messages appear on the video monitor. Refer to the following
table for a description of the messages.

Error message Description

GA20 Error An error occurred with Gate A20 when switching to protected
mode during the memory test.

Pri Master HDD Error

Pri Slave HDD Error

Sec Master HDD Error

Sec Slave HDD Error

The system could not read the sector from the corresponding
drive.

ATAPI Incompatible Drive

• Pri Master Drive

• Pri Slave Drive

• Sec Master Drive

• Sec Slave Drive

The corresponding drive is not an ATAPI (Advanced Technology
Attachment Packet Interface) device. Run Setup to make sure
the device is selected correctly.

A: Drive Error No response from the disk drive.

CMOS Battery Low The battery is losing power. Replace the battery soon.

CMOS Display Type Wron The display type is different from that stored in CMOS. Check
Setup to make sure the type is correct.

CMOS Checksum Bad The CMOS checksum is incorrect. CMOS memory can be
corrupted. Run Setup to reset the values.

CMOS Settings Wrong The CMOS values are not the same as the last boot. Either these
values are corrupted or the battery failed.

CMOS Date/Time Not Set The time or date values stored in CMOS are invalid. Run Setup
to set the correct values.

DMA Error An error occurred during the read/write test of the DMA (Direct
Memory Access) controller.

FDC Failure An FDC Failure error occurred while trying to access the diskette
drive controller.

HDC Failure An error occurred trying to access the hard disk controller.

Checking NVRAM.... The NVRAM (Non-Volatile Random Access Memory) is being
checked to see if it is valid.

Update OK! The NVRAM is invalid and has been updated.

Updated Failed The NVRAM is invalid and cannot be updated.

Keyboard Error An error occurred in the keyboard connection. Make sure the
keyboard is connected properly.

KB/Interface Error The keyboard interface test failed.
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Memory Size Decreased The memory size has decreased since the last boot. If you have
not removed any memory, then the memory may be faulty.

Memory Size Increased The memory size has increased since the last boot. If you have
not added any memory, there is a problem with the system.

Memory Size Changed The memory size has changed since the last boot. If you did not
add or remove any memory, then the memory may be faulty.

No Boot Device Available The system did not find a device to boot from.

Off Board Parity Error A parity error occurred on an offboard card. This error is followed
by the card address.

On Board Parity Error A parity error occurred in onboard memory. This error is followed
by the card address.

Parity Error A parity error occurred in onboard memory at an unknown
address.

NVRAM / CMOS /
PASSWORD cleared by
Jumper

NVRAM, CMOS, and passwords have been cleared. Power the
system down and remove the jumper.

<CTRL_N> Pressed The CMOS is ignored and NVRAM is cleared. You must enter
Setup.

System troubleshooting

Trouble symptom Action

The system boots, the fans turn at high speed
but do not return to normal speed. The system
is extremely noisy.

Two possible causes are:

• One or more fans are faulty and you need
to replace the fan module. For instructions,
see the 1005r Server Maintenance and
Diagnostics Guide (NN44200-704).

• An IMM module is faulty or incorrectly
programmed. Reflash the system board
F/W with Nortel-approved BMC and
FRU/SDR and try again.

If neither of the above actions resolves the
problem, replace the server (as the IMM board
is a non-FRU item).

The system boots and beeps, but there is no
video. (In some cases a red LED appears on
the front cover).

Refer to the error and beep codes or contact
Nortel at http://www.nortel.com/support

The system boots but a red CRT LED and an
amber PWR LED appears.

One power supply is faulty, or the AC cable is
unplugged (or faulty).
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The system boots but PCI errors appear or fill
the screen.

Ensure the PCI raiser assembly is plugged in
correctly, aligned, and firmly pressed into the
slot. You must complete the reseating with the
server out of the rack and on a solid surface.
Ensure the power cable is plugged in.

The system boots, but a blue screen appears. Ensure the PCI raiser assembly is plugged in
correctly, aligned, and firmly pressed into the
slot. You must complete the reseating with the
server out of the rack and on a solid surface.

The system boots, but does not detect the RAID
card.

Ensure the PCI raiser assembly is plugged in
correctly, aligned, and firmly pressed into the
slot. You must complete the reseating with the
server out of the rack and on a solid surface.

The system (with only one MPB96 card) boots,
but stops with a PCI error.

The MPB96 card is not plugged in to the top
full-sized slot (slot FS1; FS=full sized).

The system boots, but does not report that one
power supply is disconnected or that the cable
is unplugged. The front panel LEDs do not
display in multiple colors.

The system does not have the correct Nortel
customized FRU/SDR firmware, or the firmware
was loaded while these components were
disconnected.

Ensure all of the power supplies are plugged in
and connected to the AC and the system is fully
configured. Run the system board firmware
and BIOS upgrade using the CallPilot image
CD/DVD. Ensure the BIOS settings are verified
after this procedure.

During an upgrade, the upgrade wizard states
that the processor configuration is incorrect.

Ensure the BIOS settings are correct (including
the hyper-threading setting) and that both
processors are working properly.

The system starts to boot but two red lines
appear at the bottom of the screen and the
message cannot be read.

The server recovered from a system error
(processor internal IERR error). To clear the
resulting error message from the log, perform
the following steps:
1. Reboot the system.

2. Press F2 so that the system boots into the
BIOS.

3. Set Re-test to Enabled in the BIOS under
Advanced Processor Configuration > Processor.

4. Exit BIOS and power down.

5. Disconnect both power cords for about
1 minute to allow the complete reset of the
firmware module.

6. Re-connect the power cords.

7. Power on the system.
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8. Boot into service.

During startup, a message indicates that the
System Event Log is full and the log must be
cleared.

This is an unusual situation and appears only
if the server was booted many times. View
the log before clearing it. See the 1005r
Hardware Maintenance and Diagnostics guide
NN44200-704 for viewing and clearing the
System Event Log.

After startup, the Intel Server Manager reports
that one of the processors is disabled. This
causes the system processes to slow down.

1. Power down the server.

2. Disconnect the power cord and wait 2
minutes.

3. Connect the power cord.

4. Power up the server.

SCSI and tape drive troubleshooting

Trouble Action

The SLR external tape drive was hot plugged
but does not appear in the device manager.

Select a device within the Windows device
manager and then select Action > Rescan. The
drive should be detected. If not, ensure the
correct driver is installed.

If this does not resolve the problem, ensure the
external drive is powered up and not faulty.

Observe the LED codes on the tape drive for
errors pertaining to the tape drive only.

The tape drive is plugged in correctly, but the
system experiences errors. (The drive cannot
be re-tensioned or go offline randomly).

The tape drive may have been plugged into
the RAID external SCSI adaptor instead of
the SCSI adaptor. Plug the tape into the
correct connector at the back of the server. For
instructions, see the 1005r Server Hardware
Installation Guide (NN44200-308).

RAID troubleshooting

Trouble Action

The system boots but does not detect the RAID
card.

Ensure the PCI raiser assembly is plugged in
correctly, aligned, and firmly pressed into the
slot. You must complete the reseating with the
server out of the rack and on a solid surface.

The system boots and detects the RAID card
but does not boot into Windows.

Check if any, or all, of the drives are offline.
Re-create or repair the RAID packs.
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The system boots but one of the drive LEDs on
the front panel is amber.

The RAID is split, or one of the drives is faulty
or offline. Replace or rebuild the drive.
No action is required if this is due to a voluntary
RAID split.

A drive fails and the replacement does not
rebuild.

The RAID card settings are incorrect. The
coercion algorithm is not set to 1 GB.

ATTENTION
You must complete a full system rebuild to
reconfigure the RAID cards to the correct
coercion algorithm.

The system is not rebuilding a drive or it returns
an error after the rebuild is initiated.

The hard drive is faulty. Check the driver
version or the power console version.

After a failed upgrade, both drives are brought
offline to return to a previous CallPilot release,
but the system displays a blue screen.

Do not use the power console to bring both
drives offline. Use the Ctrl+M utility.
If you disable both hard drives while in Windows,
the system crashes.

Dongle troubleshooting

Trouble Action

The dongle is plugged into the USB slot and is
detected in the device manager but CallPilot
does not recognize it.

Ensure the dongle is in USB slot 0, and not in
slot 1 or 2.

The dongle is plugged into USB slot 0 but is not
visible in the device manager. CallPilot also
does not detect it.

The dongle holder is not plugged in correctly, or
it is defective. Replace it and keep the button.
Also, ensure the button is not installed
backward. For installation instructions, see
the 1005r Server Hardware Installation Guide
(NN44200-308).

Windows and CallPilot hardware troubleshooting

Trouble Action

The system beeps, but seems
to be running properly and
taking calls.

This is a RAID card beep indicating that one of the drives does
not function properly. Do not shut down the system.
Open the Power Console Plus (CallPilot 3.x) utility, and check
which drive is marked as Dead.

Rebuild the drive marked as Dead.

If the rebuild is unsuccessful, ensure that the other drive is
working, and then shut down the system and replace the drive
marked as Dead.
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The system displays a blue
screen with the following
message: Hardware
Malfunction, please contact
your H/W vendor. The system
does not take calls.

Ensure the MPB96 board is release 5 or later.

All DSP diagnostics fail at
system startup.

Shut down the server and open the lid. Turn on the server and
check if the PCI LED on the MPB96 board is still on after startup.
If the LED is still on, then shut down the server, reseat the board,
and then turn on the server again.

• If the LED is still on, the board is defective and must be
replaced.

• If the LED goes on and then off, but the DSP and CTbus
FPGA LEDs are still on after the system boots completely to
the operating system, then check the HAL and ensure that all
its components are working properly. If the HAL components
function properly, then at least one of the ctbus.mcs or
dsp.mcs files is corrupted. Replace these files and reboot the
system. If the PCI LED still stays on, then the MPB96 board
is defective and must be replaced.

The system starts up, but
attempts to boot to the
operating system from the
network.

The RAID card was not detected due to improper seating during
PCI assembly. Remove the system from the rack and place
it on a table. Re-seat the PCI assembly by securely pushing it
into place. Ensure the slots and studs at the back are properly
aligned.

The system ELAN or CLAN is
not working, even though they
are detected and displayed in
the operating system control
panel.

Enable the NIC controllers in the BIOS.

The system displays an
error message after CallPilot
languages are installed.

There is an older version of the RAID controller firmware.
Upgrade the RAID firmware to a currently supported version. For
information about valid RAID firmware, see the 1005r Server
Maintenance and Diagnostics guide.

The HAL does not detect the
MPB96 board. All the DSPs
report failures in the diagnostic
window.

By looking at the LEDs, ensure the MPB96 is not faulty. See
MPB96 board LEDs on page.

The system does not detect
the MPB96 board after
CallPilot is migrated from an
earlier platform.

• Check if the system is detected correctly in the HAL; that is, if
the platform information file matches your system information.

• If the platform information and the system information do not
match, then load the correct platform information file into the
registry.
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The system detects the
MPB96 board only partially,
and Configuration Wizard
does not run.

The MPB96 board is configured incorrectly from the clocking
point of view.
Contact your Nortel support representative for assistance.

The system detects the
MPB96 board, but does
not correctly load the DSP
information at startup.

The cache.bin file in the D:\nortel\hardware\dsp\c52\ folder is
corrupted.
Rerun the Configuration Wizard to reflash the DSPs.

600r server
The 600r server is based on an Intel Chesnee server platform with
advanced self-troubleshooting mechanisms. You can troubleshoot errors
by observing multiple areas:

• Visual – front or rear panel LEDs

• Audio or Sound – beeps or increased fan noise pitch

• Software – remotely using network intelligent modules (SNMP and/or
event logs).

If the system is powered on, you can access error reporting using the
CallPilot image CD/DVD SEL viewer tool (if the system does not boot into
Windows). This tool reports all hardware events and saves them as a text
file on a USB media.

Server LEDs
The LEDs indicate the state of your server and can help you troubleshoot
startup problems. The following tables provide useful information about the
external and internal LEDs.

Front panel LEDs

LED Functional Description

CRT A critical system fault is an error or event that
has a fatal system impact. The system cannot
continue to operate.

MJR A major system fault is an error or event that
has a discernible impact on system operation.
The system can continue to operate but with
reduced performance or features.
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MNR A minor system fault is an error or event that
has little impact on system operation. The
system continues to operate.

PWR A power supply fault indicates that one of the
power supplies is not providing power. The
MJR LED is also lit.

External LEDs

Description Information

MPB96 DS30 link LEDs (three green LEDs
located on the card bracket and visible from the
back of the server)

When these LEDs are on, all three DS30
connections are working properly and the
cables are connected correctly. If one or more
LEDs are off, one of the following conditions is
present:

• One or more connections to the switch
are interrupted. Check each of the three
branches of the DS30 cable for faults, or
replace the cable.

• An MGate card in the switch is defective.

NIC LEDs Each network interface card (NIC) has two
LEDs:

• The upper LED shows that the network
cable is connected.

• The lower LED blinks to indicate data
transfer.

Power supply LED The power supply has its own LED:

• OFF = system or power supply is off or
faulty

• Red/Amber = power supply is faulty or
cable is disconnected

• Green = power supply is working correctly
and powered on
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Internal LEDs

Description Information

MPB96 board LEDs The three red LEDs at the top of the MPB96 board are visible through
the grill at the back of the server.

• The PCI FPGA Done LED (the closest to the card I/O bracket)
comes on at startup and turns off immediately. This indicates
that the board works properly and was detected correctly by the
system. If this LED stays on after the startup, the card is defective
and must be replaced.

• The DSP FPGA Done LED comes on at startup and stays on
until the CallPilot drivers are loaded and the diagnostic screen
appears. If the LED stays on after the operating system starts and
the CallPilot diagnostic screen appears, then the MPB96 board is
defective or the DSP and NTBus drivers do not function properly.

• The CTbus FPGA Done LED (the farthest from the card I/O
bracket) works in tandem with the DSP FPGA Done LED and
turns on and off at the same time.

POST Beep Codes
If an error occurs before video initialization, the POST emits beep codes
that indicate errors in hardware, software, or firmware.

A beep code is a series of separate tones, each equal in length. Record the
beep code sequence before calling Nortel technical support.

Beep count Description

1, 2, or 3 A Memory error occurred. Reseat the memory
or replace the DIMMs with known good
modules.

4 – 7 or 9 – 11 A fatal error occurred and indicates a possible
serious system problem. Remove all the add-in
cards and restart the system. If the error still
occurs, contact Nortel support. If the beep
codes are not generated after you remove
the add-in cards, insert the cards one at a
time, booting the system between each card
addition, until the beeps again occur to reveal
the malfunctioning card.

8 A problem with the onboard video card occurred
indicating a fault on the server board.
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BIOS error messages
When a recoverable error occurs during the POST, the BIOS displays an
error message describing the problem.

BIOS error messages appear on the video monitor. Refer to the following
table for a description of the messages.

Error message Description

GA20 Error An error occurred with Gate A20 when switching
to protected mode during the memory test.

Pri Master HDD Error

Pri Slave HDD Error

The system could not read the sector from the
corresponding drive.

ATAPI Incompatible Drive

• Pri Master Drive

• Pri Slave Drive

The corresponding drive is not an ATAPI
(Advanced Technology Attachment Packet
Interface) device. Run Setup to make sure the
device is selected correctly.

A: Drive Error No response from the disk drive.

CMOS Battery Low The battery is losing power. Replace the battery
soon.

CMOS Display Type Wron The display type is different from that stored in
CMOS. Check Setup to make sure the type is
correct.

CMOS Checksum Bad The CMOS checksum is incorrect. CMOS
memory can be corrupted. Run Setup to reset
the values.

CMOS Settings Wrong The CMOS values are not the same as the last
boot. Either these values are corrupted or the
battery failed.

CMOS Date/Time Not Set The time or date values stored in CMOS are
invalid. Run Setup to set the correct values.

DMA Error An error occurred during the read/write test of
the DMA (Direct Memory Access) controller.

FDC Failure An FDC Failure error occurred while trying to
access the diskette drive controller.

HDC Failure An error occurred trying to access the hard disk
controller.

Checking NVRAM.... The NVRAM (Non-Volatile Random Access
Memory) is being checked to see if it is valid.

Update OK! The NVRAM is invalid and has been updated.

Updated Failed The NVRAM is invalid and cannot be updated.

Keyboard Error An error occurred in the keyboard connection.
Make sure the keyboard is connected properly.
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KB/Interface Error The keyboard interface test failed.

Memory Size Decreased The memory size has decreased since the last
boot. If you have not removed any memory,
then the memory may be faulty.

Memory Size Increased The memory size has increased since the last
boot. If you have not added any memory, there
is a problem with the system.

Memory Size Changed The memory size has changed since the last
boot. If you did not add or remove any memory,
then the memory may be faulty.

No Boot Device Available The system did not find a device to boot from.

Off Board Parity Error A parity error occurred on an offboard card.
This error is followed by the card address.

On Board Parity Error A parity error occurred in onboard memory.
This error is followed by the card address.

Parity Error A parity error occurred in onboard memory at
an unknown address.

NVRAM / CMOS / PASSWORD cleared by
Jumper

NVRAM, CMOS, and passwords have been
cleared. Power the system down and remove
the jumper.

<CTRL_N> Pressed The CMOS is ignored and NVRAM is cleared.
You must enter Setup.

System troubleshooting

Trouble symptom Action

The system boots, the fans turn at high speed
but do not return to normal speed. The system
is extremely noisy.

Two possible causes are:

• One or more fans are faulty and you need
to replace the fan module. For instructions,
see the 600r Server Maintenance and
Diagnostics Guide (NN44200-703).

• Reflash the system board F/W with
Nortel-approved BMC and FRU/SDR and
try again.

If neither of the above actions resolves the
problem, replace the server.

The system boots and beeps, but there is no
video. (In some cases a red LED appears on
the front cover).

Refer to the error and beep codes or contact
Nortel at http://www.nortel.com/support
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The system boots but a red CRT LED and an
amber PWR LED appears.

One power supply is faulty, or the AC cable is
unplugged (or faulty).

The system boots but PCI errors appear or fill
the screen.

Ensure the PCI raiser assembly is plugged in
correctly, aligned, and firmly pressed into the
slot. You must complete the reseating with the
server out of the rack and on a solid surface.
Ensure the power cable is plugged in.

The system boots, but a blue screen appears. Ensure the PCI raiser assembly is plugged in
correctly, aligned, and firmly pressed into the
slot. You must complete the reseating with the
server out of the rack and on a solid surface.

During an upgrade, the upgrade wizard states
that the processor configuration is incorrect.

Ensure the BIOS settings are correct (including
the hyper-threading setting).

The system starts to boot but two red lines
appear at the bottom of the screen and the
message cannot be read.

The server recovered from a system error
(processor internal IERR error). To clear the
resulting error message from the log, go to the
processor menu in BIOS and set the processor
re-test to enabled.

During startup, a message indicates that the
System Event Log is full and the log must be
cleared.

This is an unusual situation and appears only if
the server was booted many times. View the log
before clearing it. See the 600r Maintenance
and Diagnostics guide NN44200-703 for
viewing and clearing the System Event Log.

Server appears to boot but cannot find the hard
drive.

This is likely due to the absence of the SCSI
terminator on the back of the server. If the
tape drive is plugged in, ensure it has the SCSI
terminator installed.

SCSI and tape drive troubleshooting

Trouble Action

The SLR external tape drive is plugged in but is
not recognized by the device manager.

Select a device within the Windows device
manager and then select Action > Rescan. The
drive should be detected. If not, ensure the
correct driver is installed.

If this does not resolve the problem, ensure the
external drive is powered up and not faulty.

Observe the LED codes on the tape drive for
errors pertaining to the tape drive only.
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Ensure the SCSI tape drive has the external
SCSI terminator installed.

The tape drive is plugged in correctly, but the
system experiences errors. (The drive cannot
be re-tensioned or go offline randomly).

The tape drive may have been plugged into
the RAID external SCSI adaptor instead of
the SCSI adaptor. Plug the tape into the
correct connector at the back of the server. For
instructions, see the 600r Server Hardware
Installation Guide (NN44200-307).

RAID troubleshooting

Trouble Action

The system boots but does not detect the RAID
card.

Ensure the PCI raiser assembly is plugged in
correctly, aligned, and firmly pressed into the
slot. You must complete the reseating with the
server out of the rack and on a solid surface.

The system boots and detects the RAID card
but does not boot into Windows.

Check if any, or all, of the drives are offline.
Re-create or repair the RAID packs.

The system boots but one of the drive LEDs on
the front panel is amber.

The RAID is split, or one of the drives is faulty
or offline. Replace or rebuild the drive.
No action is required if this is due to a voluntary
RAID split.

A drive fails and the replacement does not
rebuild.

The RAID card settings are incorrect. The
coercion algorithm is not set to 1 GB.

ATTENTION
You must complete a full system rebuild to
reconfigure the RAID cards to the correct
coercion algorithm.

The system is not rebuilding a drive or it returns
an error after the rebuild is initiated.

The hard drive is faulty. Check the driver
version or the power console version.

After a failed upgrade, both drives are brought
offline to return to a previous CallPilot release,
but the system displays a blue screen.

Do not use the power console to bring both
drives offline. Use the Ctrl+M utility.
If you disable both hard drives while in Windows,
the system crashes.
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Dongle troubleshooting

Trouble Action

The dongle is plugged into the USB slot and is
detected in the device manager but CallPilot
does not recognize it.

Ensure the dongle is in USB slot 0, and not in
slot 1 or 2.

The dongle is plugged into USB slot 0 but is not
visible in the device manager. CallPilot also
does not detect it.

The dongle holder is not plugged in correctly, or
it is defective. Replace it and keep the button.
Also, ensure the button is not installed
backward. For installation instructions, see
the 600r Server Hardware Installation Guide
(NN44200-307).

Windows and CallPilot hardware troubleshooting

Trouble Action

The system beeps, but seems to be running
properly and taking calls.

This is a RAID card beep indicating that one of
the drives does not function properly. Do not
shut down the system.
Open the Power Console Plus (CallPilot 3.x)
utility, and check which drive is marked as
Dead.

Rebuild the drive marked as Dead.

If the rebuild is unsuccessful, ensure that the
other drive is working, and then shut down the
system and replace the drive marked as Dead.

The system displays a blue screen with the
following message: Hardware Malfunction,
please contact your H/W vendor. The system
does not take calls.

Ensure the MPB96 board is release 5 or later.

All DSP diagnostics fail at system startup. Shut down the server and open the lid. Turn
on the server and check if the PCI LED on the
MPB96 board is still on after startup. If the LED
is still on, then shut down the server, reseat the
board, and then turn on the server again.

• If the LED is still on, the board is defective
and must be replaced.

• If the LED goes on and then off, but the
DSP and CTbus FPGA LEDs are still on
after the system boots completely to the
operating system, then check the HAL and
ensure that all its components are working
properly. If the HAL components function
properly, then at least one of the ctbus.mcs
or dsp.mcs files is corrupted. Replace
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these files and reboot the system. If the PCI
LED still stays on, then the MPB96 board is
defective and must be replaced.

The system starts up, but attempts to boot to
the operating system from the network.

The RAID card was not detected due to
improper seating during PCI assembly.
Remove the system from the rack and place
it on a table. Re-seat the PCI assembly by
securely pushing it into place. Ensure the slots
and studs at the back are properly aligned.

The system ELAN or CLAN is not working, even
though they are detected and displayed in the
operating system control panel.

Enable the NIC controllers in the BIOS.

The system displays an error message after
CallPilot languages are installed.

There is an older version of the RAID controller
firmware. Upgrade the RAID firmware to a
currently supported version. For information
about valid RAID firmware, see the 1005r
Server Maintenance and Diagnostics guide.

The HAL does not detect the MPB96 board.
All the DSPs report failures in the diagnostic
window.

By looking at the LEDs, ensure the MPB96 is
not faulty. See MPB96 board LEDs on page.

The system does not detect the MPB96 board
after CallPilot is migrated from an earlier
platform.

• Check if the system is detected correctly in
the HAL; that is, if the platform information
file matches your system information.

• If the platform information and the system
information do not match, then load the
correct platform information file into the
registry.

The system detects the MPB96 board only
partially, and Configuration Wizard does not
run.

The MPB96 board is configured incorrectly from
the clocking point of view.
Contact your Nortel support representative for
assistance.

The system detects the MPB96 board, but
does not correctly load the DSP information at
startup.

The cache.bin file in the D:\nortel\hardware\dsp
\c52\ folder is corrupted.
Rerun the Configuration Wizard to reflash the
DSPs.
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Chapter 4
Network troubleshooting

In this chapter
"Check cabling" (page 59)

"Check end-to-end connectivity" (page 59)

"Check network adapters and driver installation" (page 59)

"Check TCP/IP configuration" (page 60)

"Test the TCP/IP" (page 82)

"Check event logs" (page 83)

Check cabling
Ensure that the link LEDs at both ends of each Ethernet cable are on. If
the link LEDs are not on, then ensure that the cross-over cables are not
being used in error. Try different cables if the link LEDs do not come on.
Use proper cables rated for at least 100 Mb/s; for example, category 5 UTP
cables.

Check end-to-end connectivity
Ensure that any intermediate Ethernet switches or hubs, routers, and
firewalls are properly connected and configured.

Check network adapters and driver installation

Step Action

1 Start the Windows Device Manager:

a. Click Start > Settings >Control Panel.
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b. Double-click System.

c. Click the Hardware tab.

d. Click Device Manager.

2 Expand the Network Adapters tree by clicking the plus sign (+) to
the left of this device entry.

Result: Two Ethernet adapters are displayed under Network
Adapters.

3 Right-click the first network adapter, and then click Properties on
the shortcut menu.

Result: The network adapter Properties dialog box appears.

4 Depending on the information displayed in the Properties dialog box
of the network adapter, proceed as follows:

a. If the device is disabled, enable it.

b. If the device is not working properly, try reinstalling the device
driver.

c. If you are unable to reinstall the device driver, a hardware
problem can affect the adapter.

5 Perform steps 3 and 4 for the second network adapter.

—End—

Check TCP/IP configuration
The TCP/IP communication works only if the TCP/IP configuration is correct.
Ensure that the subnet mask information is correct and that the default
gateway address is on the same subnet.

The following procedure outlines the steps necessary for troubleshooting
TCP/IP configuration issues. Ensure that all settings, as well as the
variables specific to your installation, are correct.

ATTENTION
Do not use the IP addresses and names shown in the illustrations. Use the values
provided by your network administrator.

Step Action

1 Click Start > Settings > Network and Dialup Connections.

Result: The Network Connections window appears.
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2 Right-click CLAN, and then click Status on the shortcut menu.

Result:The following dialog box appears.

3 Click the Support tab.
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4 Click Details.

Result:The following box appears.

5 Click Close.

6 Click Repair on the network adapter status dialog box

Result:The following dialog box appears.
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7 Click OK (this error is normal).

8 Click the General tab of the network adapter status dialog box, and
then click Properties.

Result:The following dialog box appears.
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9 Click the Internet Protocol (TCP/IP) entry to select it.
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10 Click Properties.

Result:The following dialog box appears.
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11 Click Advanced.

Result:The following dialog box appears.
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12 Click the DNS tab. Check that the settings are correct for your
private network.
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13 Click the WINS tab.
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Note: WINS IP addresses must be entered for your private
network.

14 Click the Options tab. Check that the settings are correct for your
private network.
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15 Click Properties on the Options tab to display information about
TCP/IP filtering. Check that the settings are correct for your private
network.
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16 Click Cancel to close the TCP/IP filtering dialog box.

17 Click Cancel to close the Advanced TCP/IP Settings dialog box.

18 Click the Authentication tab in the CLAN Properties dialog box.
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19 Click the Advanced tab in the CLAN Properties dialog box.
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20 Click the General tab in the CLAN Properties dialog box.
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21 Click Configure.

Result: The Ethernet adapter Properties dialog box appears.
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22 Click the Advanced tab.
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The default property values in the Advanced tab differ according to
the link and CallPilot platform used. The following tables provide the
default values for different cases.

Note: Other values can work and can be acceptable under
certain circumstances.

201i Intel 8255xER PCI adapter (CLAN and ELAN) default advanced
property values

Property Value

Duplex AutoDetect

IPv4* Priority Tag Disabled

IPv4* VLAN Tag ID 0

Receive Buffers 16
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Property Value

Speed AutoDetect

Transmit Control
Blocks

8

703t Intel PRO/1000 MT network controller (CLAN) default advanced
property values

Property Value

Fast Transmit
Completion

On

Flow Control Both on

Link Speed &
Duplex

AutoDetect

Locally Administer
ed Address

Not Present

Number of
Coalesce Buffers

128

Number of Receive
Buffers

256

Number of Transm
it Descriptors

256

Offload Receive IP
checksum

On

Offload Receive
TSP checksum

On

Offload TCP
Segmentation

On

Offload Transmit
IP Checksum

On

Offload Transmit
TCP Checksum

On

703t Intel 8255x-based PCI Ethernet adapter (10/100) [ELAN] default
advanced property values

Property Value

802.1p QoS
Packet Tagging

Disabled

Checksum Enabled

Coalesce Buffers 8
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Property Value

Flow Control
Settings

Off

IP Security Enabled

Large Send Enabled

Link Speed &
Duplex

AutoDetect

Locally Administer
ed Address

Not Present

Receive Buffers 48

Security Associatio
ns

64

Smart Power Down Enabled

Transmit Control
Blocks

16

1002rp Intel 8255x-based PCI Ethernet adapter (10/100) [CLAN and
ELAN] default advanced property values

Property Value

802.1p QoS
Packet Tagging

Disabled

Adaptive Link
Response

Off

Coalesce Buffers 8

Flow Control
Settings

Off

Large Send Enabled

Link Speed &
Duplex

AutoDetect

Locally Administer
ed Address

Not Present

Receive Buffers 48
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Property Value

Smart Power Down Disabled

Transmit Control
Blocks

16

1005r Intel PRO/1000 MT Dual port Ethernet adaptor - default advanced
property values

Property Value

Adaptive Inter-Frame Spacing Enabled

Enable PME OS controlled

Express Teaming Teaming disabled

Flow Control Generate and Respond

Interrupt Moderation Rate Adaptive

Jumbo Frames Disabled

Link Speed and Duplex Auto Detect

Locally Administered Address Not present

Log Link State Event Enabled

Offload Receive IP Checksum On

Offload Receive TCP Checksum On

Offload TCP Segmentation On

Offload Transmit IP Checksum On

Offload Transmit TCP Checksum On

Qos Packet Tagging Disabled

Receive Descriptors 256

Transmit Descriptors 256

Wait for Link Auto Detect

Wake on Link Settings Disabled

Wake on Settings OS Controlled

600r Intel PRO/1000 MT and Intel PRO/1000 CT port Ethernet adaptor -
default advanced property values

Adaptive Inter-Frame Spacing Disabled

Enable PME No action

Flow Control Generate and respond

Gigabit Master Slave Mode Hardware default

Interrupt Moderation Rate Hardware default
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Jumbo Frames Disabled

Link Speed and Duplex Auto detect

Locally Administered Address Not present

Log Link State Event Enabled

Offload Receive IP Checksum On

Offload Receive TCP Checksum On

Offload TCP Segmentation On

Offload Transmit IP Checksum On

Offload Transmit TCP Checksum On

Qos Packet Tagging Disabled

Receive Descriptors 256

Smart Power Down Hardware default

Transmit Descriptors 256

Wake on Link Settings Disabled

Wake on Settings OS controlled

23 Click the Driver tab. Check that the settings are correct for your
private network.
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24 Click the Resources tab.Check that the settings are correct for your
private network.
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25 Perform steps 2 through 22 for the ELAN adapter.

—End—

Test the TCP/IP

Step Action

1 Open a Command Prompt window.

2 Type ipconfig/all to display the network settings.
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3 Use the ping command to check if other IP addresses are reachable.
For example, ping the IP address of the switch.

Note: Do not type the IP address shown in the preceding
illustration. Use the IP address of your switch.

—End—

Check event logs
Check the system log for problems that occur when protocols are initialized
after a reboot.

To access the event logs, click Start → Programs → Administrative Tools,
and double-click Event Viewer.
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Errors in the networking configuration can result in System log events
shortly after the system boots up. Look for events with values in the Source
column such as E100B (the Intel Pro 100 adapter) and Tcpip. For example,
if a duplicate IP address or a duplicate computer name is present on the
network, the system issues event logs and networking does not work
properly. The following illustration shows the Event Viewer window.

Double-click an event to display the Information Properties dialog box. The
following illustrations are examples of Information Properties dialog boxes.
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Checking the SCSI speed for RAID controllers
Check SCSI channel speed if there are issues with the hard drive. Before
shutting down and after rebooting, check the previous power up negotiated
speed using Power Console Windows Utility. If the speed shown is anything
else but Maximum or 160M or if Asynchronous displays, there is a serious
issue with the SCSI chain. This could be either a bad termination, SCSI
backplane, cable or a drive is about to fail. Additionally, you should
immediately check the media errors on the same menu. The Asynchronous
speed is usually accompanied by media errors and sense error keys in
the logs.

SCSI speed is negotiated when the system powers up. Warm Rebooting
will not trigger a re-negotiation.

Check the SCSI speed setting of 160M using the CTRL+M utility. This will
restart the system.

Nortel CallPilot
Troubleshooting Reference Guide
NN44200-700 01.05 Standard

5.0 26 June 2007
Copyright © 2007, Nortel Networks

.

Download from Www.Somanuals.com. All Manuals Search And Download.



Checking the SCSI speed for RAID controllers 87

To check the SCSI speed

Step Action

1 Start the system and press CTRL+M when prompted during system
startup. The CTRL+M utility can take up to one minute to launch with
1L37 firmware. The system can appear frozen. Do not reset.

2 From the Objects menu, select Adapter > Other Adapter
Information.

The SCSI speed is displayed here.

—End—
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Chapter 5
Routing and remote access
troubleshooting

In this chapter
"General" (page 89)

"Modem" (page 90)

"Routing and Remote Access" (page 99)

"Symantec pcAnywhere" (page 109)

"Microsoft Remote Desktop Connection (RDC)" (page 112)

General
Follow these general steps to connect remotely to a CallPilot server.

1. Use dial-up networking on a Windows client PC to dial into the CallPilot
server and establish a TCP/IP connection over the dial-up modem link.

2. Start a Symantec pcAnywhere session over the established TCP/IP
connection.

The remote connection functions properly only if the following components
are correctly configured:

• the modem

• the Routing and Remote Access Service (RRAS) in Windows 2003

• the pcAnywhere host
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Modem
The preliminary modem troubleshooting routine consists of ensuring that:

• The modem is functioning and ready to accept calls.

• The modem is properly connected to the COM1 serial port, or the USB
port for the 1005r.

• The modem is connected to an analog telephone line.

Recognizing that the modem is functioning
The modem is functioning and ready to accept calls if both the Carrier
Sense (CS) and Terminal Ready (TR) lamps are lit.

The CS light comes on when the modem is turned on. The TR lamp may
not be lit after the following events:

• The modem is disconnected or turned off when CallPilot is rebooted.

• The modem is turned off and on, or is disconnected and reconnected
from the power supply while in operation.

CallPilot rebooted and modem disconnected or turned off
Perform the following steps to bring the modem into service:

Step Action

1 From the desktop, right-click on My Computer → Manage → Device
Manager.

Result: The list of devices appears.

2 Locate the Modem in the list. If Modems are not listed, right-click on
the top device (the computer name) and select Scan for hardware
changes.

Result: The screen flashes a couple of times and the list of Modems
appears.

3 The TR lamp is now lit and the modem ready to accept calls.

—End—

Modem disconnected or turned off while in operation
Perform the following steps to bring the modem into service:

Step Action

1 From the desktop, right-click on My Computer → Manage → Device
Manager.
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Result: The list of devices appears.

2 Locate the Modem in the list.

If Modems are not listed:

a. Right- click on the top device (the computer name) and select
Scan for hardware changes.

Result: The screen flashes a couple of times and the list of
Modems appears.

If Modems are listed:

b. Click + to expand the list. This makes the connected modem
visible.

c. Right-click on the active modem and select Disable driver.

Result: The message box Disabling this device will cause it to
stop functioning... appears

d. Click the Yes button.

e. Right-click on the active modem and select Enable.

3 The TR lamp is now lit and the modem ready to accept calls.

—End—

Troubleshooting modem configuration
The following procedure outlines the steps necessary for troubleshooting
modem configuration issues. Ensure that all settings, as well as the
variables specific to your installation, are correct.

ATTENTION
Do not use the exact information shown in the illustrations. Use the values
provided by your network administrator.

Step Action

1 Click Start → Settings → Control Panel, and then double-click Phone
and Modem Options.

Result: The Phone and Modem Options dialog box appears.
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2 Click the Modems tab.
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3 Click Properties.

Result: The modem Properties dialog box appears.
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4 Click the Modem tab. Verify settings.
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5 Click the Diagnostics tab.
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6 Click Query Modem.

Result: After a delay of several seconds, the system displays the
response from the modem. The following illustration indicates that
the modem is working.
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7 Click the Advanced tab. Verify settings.
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8 Click the Driver tab. Verify settings.
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9 Click Close, and then close the Phone and Modem Options dialog
box.

—End—

Routing and Remote Access
The following procedure walks you through the steps necessary for
troubleshooting RRAS issues in Windows 2003. Ensure that all settings, as
well as the variables specific to your installation (such as server names and
IP addresses), are correct.

ATTENTION
The illustrations show the default RRAS configuration. Under some
circumstances, other RRAS configurations can apply.
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Step Action

1 Start → Programs → Administrative Tools, and double-click Routing
and Remote Access.

Result: The Routing and Remote Access Window appears.

2 Click the plus sign (+) to the left of the server name in the left pane
to expand the tree.

3 Click General under IP Routing.

Result: The system displays general information associated with IP
Routing in the right pane.

4 Click the ELAN entry to select it.

5 Use the slider at the bottom of the window to scroll to the right and
view additional information.
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6 Click Remote Access Policies in the left pane.

7 Right-click Connections to Microsoft Routing and Remote Access
server, and then click Properties on the shortcut menu.

Result: The following dialog box appears.
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8 Click Edit Profile.

Result: The Edit Dial-in Profile dialog box appears.
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9 Click the IP tab.
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10 Click OK to close the Edit Dial-in Profile dialog box.

11 Right-click the server name (in this example, cplab237a) in the left
pane of the Routing and Remote Access window, and then click
Properties on the shortcut menu.

Result: The server properties dialog box appears.
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12 Click the Security tab. Verify settings.
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13 Click the IP tab. Verify settings.
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14 Click the PPP tab. Verify settings.
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15 Click the Logging tab. Verify settings.
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16 Click OK to close the server properties dialog box, and then close
the Routing and Remote Access window.

—End—

Symantec pcAnywhere
The Symantec pcAnywhere must be running so that the remote connection
to a CallPilot server can be established. A blue-green square with a check
mark at the bottom right of the CallPilot local console indicates that the
pcAnywhere is running

By default, CallPilot has a pcAnywhere host called CallPilot Support,
predefined to start automatically every time that the system boots up.
The following procedure presents the settings of the CallPilot Support
pcAnywhere host. Ensure that all the settings are correct.
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ATTENTION
The illustrations show the default Symantec pcAnywhere configuration. Under
some circumstances, it can be useful to define the pcAnywhere host in other ways.

Step Action

1 Click Start → Programs → Symantec pcAnywhere.

Result: The Symantec pcAnywhere window appears.

2 Right-click CallPilot Support, and then click Properties on the
shortcut menu.

Result: The host properties dialog box appears.

3 Click the Settings tab. Verify settings.
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4 Click the Callers tab. Verify settings.

5 Click the Security Options tab. Verify settings.
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6 Click Close, and then close the Symantec pcAnywhere window.

—End—

Microsoft Remote Desktop Connection (RDC)
The Remote Desktop Client software is installed by default on Windows
XP Professional and on Windows Server 2003. However, the version
for Windows Server 2003 is slightly different from the Windows XP
version. Obtain the Windows Server 2003 version of the Remote Desktop
Connection Client from the Microsoft Web site.

Installing RDC
RDC can be installed on client PCs running Windows 95, Windows 98,
Windows ME, Windows NT 4, Windows 2000, or Windows XP using the
following procedure:

Step Action

1 Run the executable (msrdpcli.exe).

Result: InstallShield scans the computer to prepare installing the
client. When complete, the Welcome window appears.

2 Click Next to install.
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Result: The End User License Agreement window appears.

3 Accept the terms of the agreement and click on Next.

Result: The Customer Information screen appears.

4 Type in your user name, organization, and click the Anyone who
Uses this Computer button. Then click Next.

Result: The Ready to Install the Program screen appears.

5 Click Install.

Result: The Installing Remote Desktop Connection screen appears.
A status bar shows installation progress. Once the installation is
complete, the Install Shield Wizard Complete screen appears.

6 Click Finish to exit the install wizard.

—End—

Enable remote desktop feature and set policy on host
CallPilot server comes with the Remote Desktop server enabled and
configured for use by default. If necessary, remote desktop access can
be enabled or disabled as follows:

Step Action

1 From the CallPilot server desktop, right-click My Computer, then
choose Properties, and click on the Remote tab.

Result: The System Properties screen appears.
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2 Ensure the Allow users to connect remotely to this computer option
is selected. Click OK to close the window.

3 Open the Group Policy Snap-in to choose from the five options
available for remote control settings. Open a command prompt
window by clicking Start → Run.

Result: The Open window appears.

4 Type gpedit.msc and click OK or press Enter.

Result: The Group Policy Object Editor window appears.
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5 On the left side of the window, expand Computer Configuration,
Administrative Templates, Windows Components, and then select
Terminal Services.

6 On the right side of the window, double-click Sets Rules for Remote
Control Terminal Services User Sessions.

7 The Sets Rules for Remote Control Terminal Services User Sessions
window appears.

8 Select Enabled to load options into the box.

9 The default and recommended setting for CallPilot is Enabled with
Full Control without User’s Permission selected. This setting allows
for RDC sessions without requiring interaction or consent from a
local console user.

Adjust the settings as required, and click OK to close the screen.

10 Click File → Close to close the Group Policy Object Editor.

—End—

Establish a RAS connection
If the CallPilot server is not directly accessible from the Client PC through
an intranet or VPN, you must establish a Remote Access Service (RAS)
connection.
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Step Action

1 Connect to the CallPilot server using Dial-Up Networking. Use
the NGenDist or NGenSys accounts because these accounts are
enabled for dial-up access. You will need the password for the
account.

Note: The details of using Dial-up Networking vary depending
on which version of Windows Operating System is running on
the Client PC. Refer to the CallPilot NTPs, Windows Help, or
other Microsoft documentation for details.

2 Right-click the connection icon in the system tray and choose Status
(or just double-click the icon).

Result: The RAS Status window appears.

3 To obtain the IP address, select the Details tab and read the Server
IP Address.

4 Click Close on the Dial-Up Networking Status window.

—End—
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Starting the Remote Desktop Client
Private Session (preferred method)

Use this method to perform the following tasks:

• Establish a private login session remotely, not visible from the server
console.

• Utilize the CallPilot Support Tools.

• Transfer files from local PC to the CallPilot server.

• Install a PEP/Service Update that interacts with the CallPilot database.

Note: If the local console is already logged in, it will get forcibly logged
out (unsaved data will be lost). Your actions will not be visible on the
local console.

Step Action

1 From the client PC, start the Remote Desktop Connection for
Windows Server 2003 Client. Select Start → Programs → Remote
Desktop Connection or Start → Programs → Accessories →
Communications → Remote Desktop Connection.

Result: the Remote Desktop Connection window appears.

2 Enter the IP address followed by a space and the suffix /console.
The suffix sets up a private session connected to the logical console
of the CallPilot server. Click Options.

Note: For intranet or VPN connections, you can use the
computer name instead of an IP address.

Result: The Options window appears.
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3 Type the IP address or computer name, a space, and the suffix
/console.

4 Type the User name and Password.

5 Click the Local Resources tab.

Result: The Local Resources window appears.

6 Make the disk drives and printers from the client PC available on the
target CallPilot server by entering these settings:

a. Select Remote Computer Sound → Leave at remote computer.

b. Select Keyboard → On the remote computer.

c. Select the local devices to be automatically connected.

Note: Disk Drives must be checked to allow the transfer of files
(SU/PEP, logs, traces, and so on) to and from the CallPilot server.

7 Click the Display tab.

Result: The Display window appears.

8 Specify the screen size and colors for the remote desktop connection
by entering these recommended settings:

a. Select Remote Desktop Size → 800X600.

b. Select Color Depth → High Color (16 bit).

9 Click the Experience tab.

Result: The Experience window appears.
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10 Specify the connection speed (broadband or modem) that the
connection will be optimized for by entering these recommended
settings:

a. Select Performance → Modem (28.8 Kbps).

b. Select Bitmap caching → Enabled.

11 Click Connect to create the remote desktop connection.

Result: The Security Warning window appears.

12 Click OK to continue.

Result: A remote desktop session starts in a window on the client
PC.

Note: You can maximize the window to make it full screen. The
CallPilot MAS Trace Window should be visible on the task bar.
By default, this is a private session that cannot be seen from the
CallPilot local console. All disk drives from the client (including
floppy and CD drives) are mapped to the CallPilot server. Files
can be transferred by copying them using Windows Explorer.

If the RAS connection drops, the Remote Desktop Connection
will be disconnected. You can dial back in to re-establish the
RAS connection. Then reconnect using Remote Desktop Client.
You will see any windows you left open.

—End—
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Shared Session (only if local console is logged on)
Use this method in the following conditions:

• You need a shared login session to see exactly what is on the local
console, and all tasks are visible from the server console. Use a shared
login during mentoring sessions or investigating an existing alarm
message displayed on the console, and so on.)

• When the transfer of files between the local PC to the CallPilot server
will not occur.

Step Action

1 From the client PC, start the Remote Desktop Connection for
Windows Server 2003 Client. Select Start → Programs → Remote
Desktop Connection or Start → Programs → Accessories →
Communications → Remote Desktop Connection.

Result: the Remote Desktop Connection window appears.

2 Enter the IP address. Click Options.

Result: The Options window appears.

3 Type in the IP address or computer name.

4 Type the User name and Password.

5 Click the Local Resources tab.

Result: The Local Resources window appears.
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6 Make the disk drives and printers from the client PC available on the
target CallPilot server by entering these settings:

a. Select Remote Computer Sound → Leave at remote computer.

b. Select Keyboard → On the remote computer.

c. Select the local devices to be automatically connected.

Note 1: Disk drives must be checked to allow the transfer of files
(SU/PEP, logs, traces, and so on) to and from the CallPilot server.

Note 2: While file transfer is not possible in a shared session,
Nortel recommends that these settings still be selected.

7 Click the Display tab.

Result: The Display window appears.

8 Specify the screen size and colors for the remote desktop connection
by entering these recommended settings:

a. Select Remote Desktop Size → 800X600.

b. Select Color Depth → High Color (16 bit).

9 Click the Experience tab.

Result: The Experience window appears.

10 Specify the connection speed (broadband or modem) that the
connection will be optimized for by entering these recommended
settings:

a. Select Performance → Modem (28.8 Kbps).

b. Select Bitmap caching → Enabled.

11 Click Connect to create the remote desktop connection.

Result: The Security Warning window appears.

12 Click OK to continue.

Result: A remote desktop session starts in a window on the client
PC.
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13 Within the Remote Desktop session:

a. Select Start → Run, then in the Open box type cmd and click OK.

b. In the command prompt window, type shadow 0 and press
Enter.

Result: This step puts your private session on hold and starts
a shared session, allowing the local and remote consoles to
share/view the same screens. All your remote actions are visible on
the local console. Both the local and remote mouse and keyboard
are active. The screen resolution of the Remote Desktop Connection
is adjusted to match the resolution of the local console. The disk
drives shared from the client PC are not visible after you enter the
shadow 0 command.

14 The CallPilot desktop background is visible during a shared session.
This visibility can slow performance if you are connected over a
modem. You can turn off the background using Control Panel →
Display → Desktop → None. Remember to set the background back
to its original setting once your shared session is over.

Note: Browse to path: C:\windows\system32\CP3BackSplashs\
CPBAKxxxx.bmp where xxxx = platform number.

15 Cancel shadowing of the CallPilot console and return to the original
session. Hold down the CTRL key while pressing the * key on the
numeric keypad.
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Result: The shared disk drives are again visible. You can toggle
back and forth using shadow 0 and CTRL num *.

—End—

Notes:

If no numeric keypad exists (for example, using a laptop), use the Function
and * keys.

If you logout while in a shared session, console shadowing ends and you
revert to your initial private session. The local console session logs out.

PEP installs and CallPilot support tools may not work properly when you are
in an unshadowed session not connected to the console.

While in a shadow 0 session, you are unable to see your local drives on
the remote server.

If the local console is not already logged on when the shadow 0 command
is used, the system returns the following error within the Command prompt
window:
Remote Control Failed. Error 7050
Error [7050]:The requested session cannot be controlled
remotely. This may be because the session is disconnected or
does not currently have a user logged on.

You can still connect to the console session by logging out from your RDC
session, then reconnecting using the /console option.

CallPilot support tools
Certain support tools and operations (including PEP installs) only work
properly when run from the logical console. MMFS and database operations
can only be done from the logical console session. These tools must be run
using either a private session connected to the console or by using a shared
session. Once you cancel console shadowing, support tool operations may
not work unless you re-shadow.

If you wish to use support tools without the customer being able to see on
the console, use a private session. This private session logs out any local
user. You can start and stop Remote Desktop sessions without dropping
the RAS dial-up connection.

Note: PEP installs that perform database or MMFS operations may also
require use of a session connected to the console.
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There is no way to send the CTRL-ALT-DEL key combination. If you need to
reboot the CallPilot server, use Start → Shutdown.

To disconnect, log out from the NGenDist session. Logging out closes any
programs you started and terminates the Remote Desktop Client. You can
then hang up the RAS connection.

RAS dial-up required to establish RDC
Unfortunately, it is not possible to use Remote Desktop directly through a
modem. RAS dial-in must be working for this form of remote access to work.

Double-Hop remote control
A common support scenario is for one technician to dial in to a customer’s
CallPilot server, then another technician controls the first technician’s
computer (for example, by intranet or VPN), thereby gaining access to the
dial-up remote control session on CallPilot. For this operation to work, the
intermediate computer’s Dial-Up Networking TCP/IP Settings must have the
setting Use default gateway on remote network unchecked.

Step Action

1 Double-click the Dial-up Networking connection icon in the system
tray.

2 The Status window appears.

3 Click the Properties button and then select the Networking tab.

Result: The RAS Dialout Properties, Networking window appears.

4 Highlight the Internet Protocol (TCP/IP) component and click the
Properties button. Do not un-check Internet Protocol (TCP/IP).

Result: the Internet Protocol (TCP/IP) Properties window appears.

5 Click the Advanced button.

Result: The Advanced TCP/IP Settings screen appears.
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Double-Hop remote control 125

6 Uncheck Use default gateway on remote network. Click OK to close
all windows.

Result: The warning box appears with the following message:
Since this connection is currently active, some setting
will not take effect until the next time you dial it.

7 Click OK.

8 Disconnect and re-connect to the remote server. The modified
Default gateway setting is now active.

—End—

Notes:

It is possible to use pcAnywhere to control a PC that is in turn connected
into a CallPilot server through Remote Desktop Connection. However, the
right keyboard shift key does not seem to work in this scenario, nor does
the CAPS LOCK key. You must use the left shift key only to type upper
case characters. This is especially important when typing passwords. (This
problem was noted using pcAnywhere 10.5 and 11.01).
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126 Chapter 5 Routing and remote access troubleshooting

Double-Hop remote control is also possible using two Remote Desktop
Connections if the intermediate PC is running an operating system that
includes the Remote Desktop Connections Server. This method is effective
and functions optimally when both sessions are not in full-screen mode.
Refrain from maximizing the Remote Desktop windows to see them nested.

Transferring files in Remote Desktop Connection sessions
Before a file can be transferred between a local computer (the computer
that is launching the Remote Desktop Connection and making the remote
support connection session) and the remote CallPilot server, the local disk
drives must be made available during the Remote Desktop Connection
logon session.

Note: Make sure the Local devices settings include the local disk drives
to enable file transfer while in a Remote Desktop Connection session.

While in a session, moving files between the local computer and the remote
CallPilot server can be done within an Explorer window. If the Local devices
setting for disk drives was checked during the initial connection, the local
drives are displayed in the Other section as shown in the following example.

Terminal Server Maximum Connections Exceeded error
CallPilot supports a maximum of two remote sessions and one console
session concurrently. If these limits are exceeded, you might receive the
error;
The terminal server has exceeded the maximum number of
allowed connections.
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View or disconnect concurrent or previous stale sessions 127

If this occurs, it is still possible to make a connection without the need for
local intervention. Use a private session to connect, forcing any local user
to logout and allowing you to connect.

Disconnecting the Remote Desktop Connection session
You should not terminate a Remote Desktop Connection by clicking X on
the Remote Desktop Window. This action disconnects your session, but the
session continues to exist on the CallPilot server. Any programs you were
running continue to run, and you can reconnect and see the same session.

Use one of these methods to log off:

Step Action

1 In the Remote Desktop Connection window, click Start → Log Off
<username>.

Result: The Confirmation dialog box appears.

2 Click Log Off to exit the Remote Desktop Connection session.

—End—

Or

Step Action

1 In the Remote Desktop Connection window, click Start → Shutdown.

Result: The Shut Down Windows dialog box appears.

2 Select Log Off <username>, from What to do, and then click OK.

—End—

View or disconnect concurrent or previous stale sessions
Microsoft Windows Terminal Services Manager provides the following
services:

• The administrative user can view active or inactive sessions on the
server.

• Log off and/or disconnect any leftover sessions that are no longer
needed.

• Send messages to other sessions for messaging between users.
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128 Chapter 5 Routing and remote access troubleshooting

To start the Terminal services Manager select Start → Programs →
Administrative Tools → Terminal Services Manager.

Note: Similar functionality is also available from the Users tab of the
Task Manager.

Result: The Terminal Services Manager window appears.

Switch between the Users and Sessions tabs.

Troubleshooting tips
Session disconnected unexpectedly

If you are in a private console session and another user takes away the
console (either local to the server or another remote RDC session), the
Remote Desktop Disconnected message appears.

Contact the site to arrange for access, or use a shared session and then
message the other user through Windows Terminal Services Manager or
Task Manager.

Cannot connect using a private session
When trying to establish a private session, the Server Name Specified is
Invalid message appears.

If using an older version of Microsoft Remote Desktop Connection client,
upgrade to the newer Windows 2003 RDC client (this document references
version control 5.2.3790.0). Check the RDC client version by right-clicking
the title bar and selecting About.

If the RDC client cannot readily be upgraded:
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Troubleshooting tips 129

Step Action

1 Open a command prompt window on your client PC.

2 Type mstsc /console and press Enter.

Result: The RDC connection window appears.

3 Type the IP address of the server into the Computer field and click
Connect.

—End—

Unable to transfer files to the remote CallPilot server
If you cannot see local client PC files and folders from within the RDC client
session, check for the following conditions:

• The Local Devices, Disk Drives option was not checked in the Options
window before connecting to the remote server in the RDC client.

• The CallPilot server is connected using a shared session. Files will not
be visible and, therefore, cannot be transferred.

When transferring files between the CallPilot server and RDC client PC,
use a private session.

Connection to server is extremely slow
The RDC access speed is diminished if the Desktop Background setting
is turned on.

In a private session, prior to connecting, select the Experience tab →
Options → Desktop Background (unchecked).

In a shared session, after connecting and logging onto the server, right-click
on the Desktop, select Properties, then select the Desktop tab. In the
Background selection box, choose None.

Click OK to close either window.

Shared remote connection fails to start
If the local console is not already logged on when the shadow 0 command
is used, the system displays the following error:
Error [7050]:The requested session cannot be controlled
remotely. This may be because the session is disconnected or
does not currently have a user logged on.

Connect to the console session using a private session. This method does
not require a user to be logged on already.
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130 Chapter 5 Routing and remote access troubleshooting

System monitor or support tools do not return valid or legible
information

If you connect to the CallPilot server using a shared session but do not
issue the shadow 0 command, support tools and diagnostics that access
the database, may return invalid results.

Use a private session or issue the shadow 0 commend when setting up a
shared session.
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Chapter 6
Application troubleshooting

In this chapter
"Symptom 1: CallPilot answers calls, but voice services are not available"
(page 132)

"Symptom 2: A user cannot log in to the mailbox from an external phone"
(page 134)

"Symptom 3: Speech recognition does not work" (page 135)

"Symptom 4: Users cannot print or receive faxes" (page 136)

"Symptom 5: Symposium voice services do not work" (page 137)

"Symptom 6: Users cannot send messages to a telephone or a fax machine
from Desktop Messaging or My C" (page 138)

"Symptom 7: Users cannot browse CallPilot Manager if the Encoding is set
to Chinese Simplified (HZ) i" (page 139)

"Symptom 8: Users cannot access the CallPilot Manager login page from a
standalone web server running" (page 140)

"Symptom 9: CallPilot Manager users cannot connect to the CallPilot
server" (page 142)
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132 Chapter 6 Application troubleshooting

Symptom 1: CallPilot answers calls, but voice services are not available

Diagnostic steps Resolution

Perform basic checks.

1 Check the DS30X cable connected to
the MGate card on the switch.

2 Check the MGate card.

3 Check if CallPilot is configured with
the correct TNs.

A Ensure that the DS30X cable is not
defective, the MGate card operates
properly, and CallPilot is configured
with the correct TNs.

Check the DS0s and DSPs. B If the DS0s and DSPs are not active,
verify the switch configuration.

4 Check if the DS0s and DSPs are in
service and accepting calls. Refer
to the Server Maintenance and
Diagnostics guide that applies to your
server type.

C If the DS0s and DSPs are active,
but voice services are not available,
verify the prompt installation. Refer to
the Configuration and Testing Guide
that applies to your switch.

Verify the switch configuration.

5 In the switch administration console,
load overlay 32 (LD 32) and verify
that the status of the defined DS0
channels is either Idle or Login.

D If the channels were disabled, use
overlay 32 (LD 32) to enable them.
Ensure that the channels were
not disabled because of a prior
maintenance task.

Check the server IP address.

6 Check if the IP address of the
CallPilot server has been changed
since the last restart.

E If the IP address was changed, shut
down and restart the CallPilot server.

Verify the MGate card version and
placement.

F If the MGate card has a different
part number, replace it with an
NTRB18CA card.

7 If the system uses an MGate card on
an Option 11 switch, verify that:

• The MGate card has the
NTRB18CA part number.

• The card is installed in the correct
slot.

• The card from the I/O panel is
installed correctly.

G If the MGate card is not installed in
the correct slot, then install it in a
slot that is consistent with the switch
programming requirements.
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Diagnostic steps Resolution

Verify the prompt installation.

8 Open the installation log file in the
D:\nortel\sysops\MPCX\langprompts
folder.

9 Check the last line of the log file. The
last line must be "Prompt Installation
completed successfully."If you cannot
verify that the prompts were installed
successfully, they were probably not.

Note: The log file name has the
format xxxx.log, where xxxx is the
Nortel Language ID; for example, 1033
for US English. The Nortel Language
ID is specified in the cdstruct.lng file,
which is located in the root directory of
the language CD.

H Reinstall the prompts. Refer to
the Software Administration and
Maintenance guide.

Verify the new configuration.

10 In the D:\nortel\langXXXX\voice\map
folder, verify that the file
sysmap.mxxxx exists, has the date
and time of the prompt installation,
and has a reasonable size (more than
5 KB).

11 Verify that all the .l files in the
D:\nortel\langXXXX\voice\template
folder have the date and time of the
prompt installation.

12 Verify that the file imap_lng.txt exists
in the D:\nortel\langXXXX\desktop
folder.

13 If the fax feature is installed, verify
that the six .cptemp and .bmp files
exist in the D:\nortel\langXXXX\fax
folder.

14 If the automatic speech recognition
(ASR) language component
was installed (or was planned
to be installed), verify that the
D:\nortel\langxxxx\asr directory exists
and contains three .ctx files, three
.cfg files, and one .asr file.

I If any one of the verification steps
fails, you must reinstall the language.

Note: Even if all the checks are valid,
it is still possible that the language was
not installed correctly.
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134 Chapter 6 Application troubleshooting

Diagnostic steps Resolution

Verify the new configuration (continued).

15 If the ASR language component was
installed, verify that the ASR load was
flashed in the DSP.

Verify that the names of the ASR
load for a specific language are in
the flashnames.dat file, which can
be found in the root directory of the
language CD.

16 Verify that the MPB cables are not
installed inverted on the tower and
rack-mount systems.

J Install the cables correctly and then
retest.

17 Does the problem still exist? K Contact your Nortel technical support
representative for assistance.

Symptom 2: A user cannot log in to the mailbox from an external phone

Diagnostic steps Resolution

Verify internal access.

1 Check if the user can log in from an
internal phone.

A Log in to the CallPilot Manager and
perform the following tasks:

• Connect to the server.

• Click User.

• Click User search.

• Enter the search criteria for the
user.

• Ensure that the Login status is
enabled.

Verify user rights.

2 Check if the user has external login
rights.

B Ensure that the external login for
the user is enabled. Refer to the
CallPilot Administrator’s Guide
(NN44200-601).

3 Does the problem still exist? C Contact your Nortel technical support
representative for assistance.
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Symptom 3: Callers hear re-order tone when dialing or being forwarded
to CallPilot

Diagnostic steps Resolution

1. Ensure the Meridian 1 or CS1000 is not
encountering network blocking. This could be
caused by installing more than three MGate
cards in the same superloop.

A Refer to NTP 553-3021-120 CS1000M
and Meridian 1 Large System Planning and
Engineering.

2 Ensure proper ACD configuration on the
Meridian 1 or CS1000.
3 Ensure CDN and SDN have an associated
DN on the Meridian 1 or CS1000.

B Refer to NTP NN44200-302 Meridian 1 and
CallPilot Server Configuration, or NN44200-312
CS1000 and CallPilot Server Configuration.

Symptom 4: Speech recognition does not work

Diagnostic steps Resolution

Verify that speech recognition resources are
assigned to the DN.

1 In CallPilot Manager, connect to the
server and then click

System→Service Directory Number.

2 View the Speech Recognition Service
Directory Number.

3 Verify that the Media type is "Speech
Rec."

A Change the DN media type to
"Speech Rec."

Verify speech recognition on keycode.

4 If the "Speech Rec." option is not in
the Media type list, then the server
keycode does not enable the speech
recognition feature.

Note: The keycode must enable
speech recognition languages and
seats so that the speech recognition
channels answer correctly.

B Perform a keycode expansion.
Contact your Nortel order
management representative or
sales representative for assistance.
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Diagnostic steps Resolution

Verify the prompt installation.

5 Check the language installation
log file: D:\nortel\sysops\MPCX\
langprompts.xxxx.log.

6 Verify that the last line of the log file
is "Prompt Installation completed
successfully."

C Reinstall the language. Refer to
the Software Administration and
Maintenance Guide.

7 Does the problem still exist? D Contact your Nortel technical support
representative for assistance.

Symptom 5: Users cannot print or receive faxes

Diagnostic steps Resolution

Verify that fax resources are assigned to the
fax messaging DN.

1 Log in to CallPilot Manager and
proceed as follows:

• Connect to the server.

• Click System→Service Directory
number.

2 View the Service Directory Number.

3 Verify that the Media type is Fax.

4 Check if the user’s Class of Service
has Fax capability.

A Change the DN media type to Fax.

Verify that Fax option is on the keycode.

5 If the Fax option is not available on the
Media type list, the server keycode
does not enable fax features.

B Perform a keycode expansion.
Contact your Nortel order
management representative or
sales representative for assistance.

6 Does the problem still exist? C Contact your Nortel technical support
representative for assistance.
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Symptom 6: Contact Center voice services do not work
The Event Browser displays a Meridian Link* TSP or ACCESS link event.
Mailbox owners notice that calls are not answered.

Diagnostic steps Resolution

Verify that the voice port configuration is consistent across all subsystems.

1 Verify the CallPilot server
configuration.

On the CallPilot server, ensure that:

• The Contact Center IP address is properly
configured.

• The ACD queue for ACCESS channels
is configured as Contact Center Voice
Services SDN.

• The ACD queue for IVR* channels is
configured as Contact Center Voice
Services support announcement or voice
menu SDN.

• The Class ID configured in the Configuration
Wizard is equal to the ACCESS port channel
configured on the Contact Center.

2 Verify the Contact Center
configuration.

On the Contact Center, ensure that:

• The CallPilot ELAN IP address is properly
configured.

• The value of the ACCESS voice port
channel is equal to the Class ID on the
CallPilot server.

• The port number is configured as 10008.

3 Verify the switch configuration. On the switch, ensure that:

• The ACD queue for ACCESS channels
is configured as follows: IVR=YES and
ALOG=YES.

• The ACD queue for IVR channels is
configured as follows: IVR=YES and
ALOG=YES.
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Diagnostic steps Resolution

Verify that the voice port configuration is consistent across all subsystems.

• The ACCESS and IVR channels are
configured as follows: AST=0, 1 and
CLS=MMA, FLXA.

• All CallPilot server ELAN VAS IDs are
configured as follows: SECU=YES.

4 Does the problem still exist? Contact your Nortel technical support
representative for assistance.

Symptom 7: Users cannot send messages to a telephone or a fax
machine from Desktop Messaging or My CallPilot

To prevent toll fraud by Desktop Messaging and My CallPilot users, Nortel
recommends that you define access restrictions for unauthenticated SMTP
users. If users report that they are unable to send a CallPilot message to a
telephone or fax machine from their desktops, then they are connecting to
CallPilot as unauthenticated SMTP users and the Delivery to Telephone or
Fax option is not selected for unauthenticated desktop users.

Diagnostic steps Resolution

Solution 1 (recommended)

1 Select the required authentication
options in Security Modes for SMTP
Sessions.

• Log in to CallPilot Manager.

• Click Messaging→Message Delivery
Configuration.

• Scroll down to the SMTP/VPIM section
and click the Security Modes for SMTP
Sessions link.

• Select the authentication options required
for your users.

• Click Save.

2 Ensure that users provide SMTP
authentication from their e-mail
clients.

If users connect from an e-mail client supported
by Nortel (such as Microsoft Outlook, Lotus
Notes, GroupWise, or My CallPilot), then
the client-side SMTP authentication option is
automatically used if the correct authentication
options are selected in Security Modes for
SMTP Sessions on the server side.
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Diagnostic steps Resolution

Solution 2

1 Leave only the Unauthenticated
option selected in Security Modes
for SMTP Sessions, and select the
correct option in Unauthenticated
Access Restrictions. This solution is
less secure becauseCallPilot allows
unauthenticated desktop users to
send messages to external telephone
and fax numbers

• Log in to CallPilot Manager.

• Click Messaging→Message Delivery
Configuration.

• Scroll down to the SMTP/VPIM section
and click the Unauthenticated Access
Restrictions link.

• Select the Delivery to Telephone or Fax
check box.

• Click Save.

Symptom 7: Users cannot browse CallPilot Manager if the Encoding
is set to Chinese Simplified (HZ) in Microsoft Internet Explorer (the
Welcome to CallPilot page is blank)

Diagnostic steps Resolution

1 Open Internet Explorer and log in to
CallPilot Manager.The Welcome to
CallPilot Manager page is blank.

A In Internet Explorer, click
View→Encoding→Auto-Select.A
check mark appears to the left of the
Auto-Select option.

When this option is selected, Internet
Explorer can usually determine the
appropriate language encoding.

B To ensure that CallPilot Manager
pages are displayed correctly,
you must also select manually
a different encoding option than
Chinese Simplified (HZ): click
View→Encoding→More, and then
select a language encoding option
from the list.

Note: The system can prompt you to
install a new language pack. You must
have the operating system installation
CD-ROM, or know the location of the
required files on a network server, if
applicable.

2 Check the Encoding setting in Internet
Explorer: click View→Encoding.The
Chinese Simplified (HZ) option is
selected.

Note: The Chinese Simplified
(GB2312) and Chinese Traditional
options do not cause this problem.
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Diagnostic steps Resolution

C Click Refresh on the Internet Explorer
toolbar or log in to CallPilot Manager
again.

Symptom 8: Users cannot access the CallPilot Manager login page
from a standalone Web server running Windows 2003 and Internet
Information Services 5.0

Diagnostic steps Resolution

Open the CallPilot Manager login page. Add Authenticated Users and INTERACTIVE
to the Users group for the Web server.

1 On the Web server, open Internet
Explorer.

A On the Web server, click
Start→Programs→Administrative
Tools. The Administrative Tools
window opens.

2 Type http:\\web_server_name\cpmgr
in the browser Address box, or
click the bookmark to the CallPilot
Manager login page.

The following message appears:
"HTTP 500—Internal server error."

B Double-click Computer
Management.The Computer
Management console opens.

Check the Event Viewer logs. C In the left pane, click the plus sign (+)
to the left of Local Users and Groups
to expand the folder tree.

3 On the Web server, click Start→
Programs→Administrative Tools.

The Administrative Tools window
opens.

D Click the Groups folder.The contents
of the Groups folder appear in the
right pane.

4 Double-click Event Viewer.The Event
Viewer window opens.

E In the right pane, right-click Users,
and then click Properties on the
shortcut menu.

The Properties dialog box opens.
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Diagnostic steps Resolution

F Click Add.

The Select Users or Groups dialog
box opens.

G Click the name of the local computer
in the Look in list.

The users and groups established
on the local computer appear in the
upper pane.

H Click Authenticated Users in the
upper pane, and then click Add.

The Authenticated Users group
moves to the lower pane.

I Click INTERACTIVE, and then click
Add.

The INTERACTIVE entry moves to
the lower pane.

J Click OK.

K Click Apply in the User Properties
dialog box.

L Click OK.

The Properties dialog box for the
Users groups closes.

Restart the Internet Information Service.

M In the left pane of the Computer
Management console, click the plus
sign (+) to the left of Services and
Applications to expand the folder tree.

N Click Services.

5 Check the System Log for the
following events:

• 36—The server failed
to load application
’/LM/w3svc/1/root/cpmgr’.
The error was ’Server execution
failed’.

• 10010—The server {A62B60F6-4
508-4E63-9C25-63102FF3E115}
did not register with DCOM within
the required time-out.

These events indicate that the NT
AUTHORITY/Authenticated Users or
NT AUTHORITY\INTERACTIVE
entry has been removed from the
Users group.

Note: Refer to the Microsoft bulletin
Q327153 for more information.
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Diagnostic steps Resolution

The available services appear in the
right pane.

O In the right pane, right-click IIS Admin
Services, and then click Restart on
the shortcut menu.

The Restart Other Services
confirmation dialog box opens.

P Click Yes.

The IIS Admin Service restarts.

6 Go to the CallPilot Manager login
page.

7 Does the problem still exists?

Q Contact your Nortel technical support
representative for assistance.

Symptom 9: CallPilot Manager users cannot connect to the CallPilot
server

Diagnostic steps Resolution

1 When you try to log in to CallPilot
Manager, the following message
appears: "Failed to connect to
the CallPilot server. Check server
information and try again. If this
problem persists, the server may be
improperly configured."

The System and Application log events point to
a problem related to the CallPilot server name.
The name of your CallPilot server already exists
on the network. To solve this problem, proceed
as follows:

2 Verify the System event log and look
for the following events: 3870, 7023,
and 7001.

A Remove the CallPilot server from the
network.

B Change the CallPilot server name using
Configuration Wizard.

3 Verify the Application event log and
look for the following events: 41504,
41550, and 41506. C Reconnect the CallPilot server to the

network.

4 Try to log in to CallPilot Manager.

5 Does the problem still exist?

Contact your Nortel technical support
representative for assistance.
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Chapter 7
Meridian Mail to CallPilot migration
troubleshooting

In this chapter
"General" (page 11)

"Symptom 1: Error reading tape during data transfer or message migration"
(page 144)

"Symptom 2: All users cannot be migrated due to an invalid user-preferred
language ID" (page 145)

"Symptom 3: The system failed to create a map directory" (page 145)

"Symptom 4: The automatic log file backup failed" (page 146)

"Symptom 5: On a recently migrated system, a user cannot log in to the
mailbox or CallPilot does not " (page 147)

General
This chapter provides troubleshooting information for issues that can
affect the Meridian Mail* to CallPilot migration process. For additional
troubleshooting information, refer to the Meridian Mail to CallPilot Migration
Utility Guide (NN44200-502). This migration guide describes common
causes of migration errors and provides methods to solve these errors.

The Meridian Mail to CallPilot Migration Utility Guide also provides general
information on the following topics:

• correcting pre-check inconsistencies

• troubleshooting tools

• Meridian Mail data collection error messages

• CallPilot migration error messages

Nortel CallPilot
Troubleshooting Reference Guide
NN44200-700 01.05 Standard

5.0 26 June 2007
Copyright © 2007, Nortel Networks

.

Download from Www.Somanuals.com. All Manuals Search And Download.



144 Chapter 7 Meridian Mail to CallPilot migration troubleshooting

Use both the Meridian Mail to CallPilot Migration Utility Guide and this
chapter to troubleshoot migration issues.

Symptom 1: Error reading tape during data transfer or message
migration

Diagnostic steps Resolution

Verify the log file

1 Open the migration transaction log
file. The migration transaction log file
(MigTransaction.log) is located in the
D:\nortel\MPCX\Migration folder on the
CallPilot server.

2 Check the error description in the log file
for more information.

A Correct the error according to the log
information. If you cannot find a solution,
go to the next step.

Verify the type of the tape.

3 Check if the type and size of the tape
that you used to collect migration data is
supported by CallPilot.

B Use the correct tape (SLR 2.5 GB) to again
collect Meridian Mail data.

Verify the tape drive.

4 Check if the CallPilot tape drive supports
the migration tape.

5 Check if the internal or external tape drive
that you are using is properly installed and
connected.

C Ensure that the tape drive supports the
migration tape; connect the tape drive
properly.

Verify the tape driver.

6 Open the Tape Devices box in Control
Panel, and determine if the required
devices and drivers are installed and
loaded or started.

D If the device driver is missing, install it. If
the device driver is not started, start it. If
you cannot start the device driver, reinstall
it and then restart the CallPilot server.

Rerun the tape on the same CallPilot server.

7 Restart the migration using exactly the
same command syntax as used to start
the migration initially.

E If the system still displays an error
message, go to the next step.

Run another data or message tape on the
same CallPilot server.

F If the system does not display an error
message, then the tape is the cause of the
problem. Use another blank tape to collect
data and then perform the migration again.

8 Ensure that the tape is serviceable before
using it. Type the correct command in
the command line window to start the
migration. If the situation does not allow
you to do this, then skip this step.

G If the system still displays an error
message, the problem is on the CallPilot
server. Reboot the CallPilot server.

Nortel CallPilot
Troubleshooting Reference Guide
NN44200-700 01.05 Standard

5.0 26 June 2007
Copyright © 2007, Nortel Networks

.

Download from Www.Somanuals.com. All Manuals Search And Download.



Symptom 3: The system failed to create a map directory 145

Diagnostic steps Resolution

Rerun the tape on a different CallPilot server. H If the system does not display an error
message, then the tape is good and the
problem is on CallPilot server. Reboot the
CallPilot server.

9 Type the correct command in the command
line window to start the migration. If the
situation does not allow you to do this, skip
this step.

I If the system still displays an error
message, then the tape is the cause of
the problem. Use another blank tape
to perform the data collection and then
perform the migration again.

1
0

Does the problem still exist? J Contact your Nortel technical support
representative for assistance.

Symptom 2: All users cannot be migrated due to an invalid
user-preferred language ID

Diagnostic steps Resolution

Verify the CallPilot version and the Meridian
Mail migration utility tape version.

1 Open the migration transaction log
file. The migration transaction log file
(MigTransaction.log) is located in the
D:\nortel\MPCX\Migration folder on the
CallPilot server.

A If you found error messages similar to
the example provided in step 2, you may
not be running a supported CallPilot
build. Refer to the Upgrade and Platform
Migration Guide (NN44200-400) for
supported versions and detailed migration
instructions.

2 Check for error messages similar to the
following:

ERROR:(USRAPI):(55122):Invalid
input USER PREFFERRED LANG ID:

B If you did not find error messages similar
to the example provided in step 2,
contact your Nortel technical support
representative for assistance.

3 Does the problem still exist? C Contact your Nortel technical support
representative for assistance.

Symptom 3: The system failed to create a map directory

Diagnostic steps Resolution

Verify the log file.

1 Open the migration transaction log
file. The migration transaction log file
(MigTransaction.log) is located in the
D:\nortel\MPCX\Migration folder on the
CallPilot server.

A If you found the error message provided
in step 2, you probably changed the
current directory at the command line. If
necessary, change the directory to
D:\nortel\MPCX\Migration and start the
migrate.exe program again.

2 Check for the following error message:
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146 Chapter 7 Meridian Mail to CallPilot migration troubleshooting

Diagnostic steps Resolution

Note: You must always start the
migration program from the directory
D:\nortel\MPCX\Migration.

B If you still have problems when you start
the program from the correct directory,
check the same directory to find a file
named nmmgmap.dat. Restore this file if
it was accidentally renamed or moved to
another directory. Reinstall the CallPilot
software if the nmmgmap.dat file is
missing.

Note: The nmmgmap.dat file must exist in
the
D:\nortel\MPCX\Migration directory.

ERROR:(MAPFILE):(100): Map
directory creation error:

C If you did not find the error message
provided in step 2, contact your Nortel
technical support representative for
assistance.

3 Does the problem still exist? D Contact your Nortel technical support
representative for assistance.

Symptom 4: The automatic log file backup failed

Diagnostic steps Resolution

Verify the disk space.

1 Open the migration transaction log
file. The migration transaction log file
(MigTransaction.log) is located in the
D:\nortel\MPCX\Migration folder on the
CallPilot server.

A If you found the error message provided
in step 2, check the free space on
the D drive (where the directory
\nortel\MPCX\migration is located) on the
CallPilot server. The system probably
does not have enough disk space to back
up the log files. Empty the Recycle Bin or
move some log files to another disk drive.
Back up the log file manually.

2 Check for the following error message:

Could not backup the.
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Diagnostic steps Resolution

Note: Older CallPilot releases do not
support the automatic log file backup.
Nortel recommends that you back up the
log file manually each time you finish a
migration tape.

transaction log file

B If you did not find the error message
provided in step 2, contact your Nortel
technical support representative for
assistance.

3 Does the problem still exist? C Contact your Nortel technical support
representative for assistance.

Symptom 5: On a recently migrated system, a user cannot log in
to the mailbox or CallPilot does not recognize a user receiving an
incoming call

Diagnostic steps Resolution

Check user’s class of service

1 On Meridian Mail, determine if the user
had a personal Class of Service (COS).
You can also verify this by checking the
migration transaction log file
(MigTransaction.log) in the
D:\nortel\MPCX\migration\ folder on the
CallPilot server.

Note: Before you migrate Meridian Mail
users to CallPilot, you must reassign the
personal COS to a dummy COS. Refer to
the Meridian Mail System Administration
Guide (NN44200-601) for information on
adding and reassigning COSs. CallPilot
does not migrate personal COSs and users
with personal COSs.

D If the user does not have a personal COS,
go to the next step. Otherwise, perform
one of the following tasks:

• Again collect the user data from
Meridian Mail after reassigning the
user COS. Perform the user migration
again.

• Use CallPilot Manager to add the
non-migrated users to the CallPilot
system. Refer to the CallPilot
Administrator’s Guide.

Note: Before you recreate a user, ensure
that the user’s DN has not already been
assigned to another user. CallPilot does not
allow duplicate DNs.

Check user’s mailbox number. E If the user has a mailbox number that is
more than three digits in length, go to the
next step.
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148 Chapter 7 Meridian Mail to CallPilot migration troubleshooting

Diagnostic steps Resolution

2 On Meridian Mail, check if the user
has a mailbox number that is less
than three digits in length. You can
also check the migration transaction
log file (MigTransaction.log) in the
D:\nortel\MPCX\Migration\ folder on the
CallPilot server.

Note: CallPilot does not support mailbox
numbers that are less than three digits in
length.

F If the user has a mailbox number that is
less than three digits in length, perform
one of the following tasks:

• Change the user mailbox number to
a three-digit number, and then again
collect user data from Meridian Mail.
Perform the user migration again.

• Use CallPilot Manager to add
non-migrated users to the CallPilot
system. Refer to the CallPilot
Administrator’s Guide.

Check the migration transaction log file.

3 Check the migration transaction
log file (MigTransaction.log) in the
D:\nortel\MPCX\Migration\ folder on the
CallPilot server to determine if the user
was migrated successfully.

4 Check the Meridian Mail log file. View it
from the Meridian Mail→Tools menu.

G If the user was migrated successfully,
check the CallPilot system sanity. If the
user was not migrated, perform one of the
following tasks:

• Again collect user data from Meridian
Mail after correcting the user property
or any other errors depending on the
CallPilot migration log information.
Perform the user migration again.

• Use CallPilot Manager to add
non-migrated users to the CallPilot
system. Refer to the CallPilot
Administrator’s Guide.

5 Does the problem still exist? H Contact your Nortel technical support
representative for assistance.
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